Xerox® DocuShare®
User Guide
# Table of Contents

1. Introduction ........................................................................................................... 6  
   DocuShare product editions ......................................................................................... 6
2. Getting started ......................................................................................................... 8  
   Overview ........................................................................................................................ 8
   Accessing DocuShare ................................................................................................... 8
   Navigating DocuShare .................................................................................................. 9
   Logging in and out ....................................................................................................... 10
   How to get help ........................................................................................................... 11
3. Managing accounts ................................................................................................ 12  
   About accounts .......................................................................................................... 12
   User accounts ............................................................................................................. 12
      Creating a user account ............................................................................................ 12
      Viewing user account properties ........................................................................... 13
      Changing your user account properties ................................................................. 13
      Changing your password ......................................................................................... 13
      Changing your username ......................................................................................... 14
      Viewing your usage quotas ...................................................................................... 14
      Changing your domain ............................................................................................. 15
      Selecting a theme ..................................................................................................... 15
      Viewing your activity history ................................................................................... 15
      Deleting a user account ............................................................................................ 16
   Group accounts .......................................................................................................... 16
      Creating a group ........................................................................................................ 16
      Viewing group properties ........................................................................................ 17
      Changing group properties ...................................................................................... 17
      Viewing the usage quotas for a group ..................................................................... 17
      Changing the members of a group .......................................................................... 18
      Changing the owner of a group ............................................................................... 18
      Changing the domain of a group ............................................................................. 19
      Sending mail to group members ............................................................................. 19
      Viewing the change history ..................................................................................... 20
      Deleting a group ....................................................................................................... 20
      Finding and listing site accounts ............................................................................ 20
4. Adding and managing content ............................................................................... 22  
   About DocuShare objects .......................................................................................... 22
   Object permissions ...................................................................................................... 23
   Adding objects ............................................................................................................ 24
      Selecting the objects that appear in the Add menu .................................................. 24
Viewing objects in containers .................................................................................................................. 25
Viewing and changing object properties .................................................................................................. 26
   Viewing the change history ..................................................................................................................... 26
Multiselect View ....................................................................................................................................... 27
   View a Document .................................................................................................................................. 27
Edit and View Properties .......................................................................................................................... 27
Generating object reports .......................................................................................................................... 27
Managing access to objects ....................................................................................................................... 28
   Viewing the access list of an object ......................................................................................................... 28
   Changing the access list of an object ....................................................................................................... 28
   Changing the owner of an object ............................................................................................................ 29
Applying permissions to the objects in a container .................................................................................. 30
Applying permissions to a document and its versions ............................................................................. 31
Changing the location of objects ............................................................................................................. 31
   Using Copy, Cut, and Paste to change the location of an object ............................................................ 32
   Copy Template as a Web Function .......................................................................................................... 33
Editing multiple objects in a collection ...................................................................................................... 33
Deleting objects ......................................................................................................................................... 35

5. Working with documents .................................................................................................................... 36

   About documents .................................................................................................................................. 36
   Adding a document ............................................................................................................................... 36
      Adding documents using the Add menu .............................................................................................. 36
      Adding documents using drag and drop ............................................................................................ 37
      Adding documents using Document Upload Page ............................................................................ 37
         Upload page Arguments ................................................................................................................... 38
         URL Examples ................................................................................................................................. 40
         Identifying properties on the object ................................................................................................. 40
         Document upload process: ............................................................................................................. 40
         Drag and Drop Feature .................................................................................................................... 40
         Document Properties ...................................................................................................................... 40
   Viewing a document ............................................................................................................................. 41
      Viewing a document and its properties ............................................................................................ 41
      Viewing an HTML rendition of a document ....................................................................................... 42
      Viewing a PDF rendition of a document ............................................................................................ 42
   Adding a new document version .......................................................................................................... 42
      Editing a document ............................................................................................................................ 42
      Uploading a new version of a document ............................................................................................ 43
   Managing document versions .............................................................................................................. 44
      Viewing document versions ................................................................................................................ 44
      Changing the preferred version ......................................................................................................... 44
      Viewing the renditions of a version .................................................................................................... 45
      Viewing and changing version properties ......................................................................................... 45
   Locking and unlocking a document .................................................................................................... 46
   Annotate and redact documents ........................................................................................................... 46
   Search for content to annotate and redact ............................................................................................ 46
### Table of Contents

1. **Adding content**
   - Add annotations ................................................................. 47
   - Add text hyperlink annotations ............................................. 48
   - Redact content ......................................................................... 48
   - Redact search results ............................................................. 48
   - Redact full pages ..................................................................... 48
   - Redact selected text ............................................................... 49
   - Merge annotations and redactions ........................................... 49
   - Burn in annotations and redacted content ............................... 50

2. **Exporting documents** ................................................................ 50
3. **Adding comments to a document** ............................................. 50
4. **Scanning documents** ................................................................ 51
   - Scanning documents using scan cover sheets ........................... 51
     - Creating a scan cover sheet .................................................. 52
     - Scanning a document with a scan cover sheet ..................... 52
     - Deleting a scan cover sheet ............................................... 52
     - Scanning documents to a temporary scan collection ............ 53
     - Saving a scanned document to a collection .......................... 53

5. **6. Setting up notifications** ............................................................... 55
   - About notifications ................................................................. 55
   - Adding a notification ............................................................... 55
   - Viewing notifications .............................................................. 56
   - Creating a recipient list for a notification ............................... 57
   - Viewing and changing notification properties .......................... 58
   - Deleting a notification ............................................................. 58
   - Customizing notifications ....................................................... 59
      - Customizing the subscription.tpl file ................................. 59
         - The subscription.tpl file .................................................. 63

6. **7. DocuShare workspaces** .......................................................... 65
   - About workspaces ..................................................................... 65
   - Adding a workspace .............................................................. 65
   - Controlling access to the workspace ....................................... 66
      - Changing the users and groups in the membership group ...... 66
      - Re-assigning the membership group ................................... 67
   - Adding content to the workspace .......................................... 67
   - Managing shortcuts ............................................................... 68
   - Using calendars ....................................................................... 68
   - Changing portlet properties .................................................. 69

7. **8. Using social computing features** ............................................ 70
   - About social computing features ............................................ 70
   - Adding a discussion .............................................................. 70
      - Adding topics, attachments, and replies to a discussion .......... 71
      - Viewing and deleting expired topics .................................... 72
      - Adding a weblog ............................................................... 72
Posting weblog entries ........................................................................................................ 73
Editing weblog entries ...................................................................................................... 73
Deleting weblog entries .................................................................................................... 73
Approving weblog entries ............................................................................................... 74
Adding comments to entries ............................................................................................ 74
Viewing comments ........................................................................................................... 74
Deleting comments .......................................................................................................... 75
Adding a wiki ..................................................................................................................... 75
Adding content to a wiki ................................................................................................... 76
Adding content to the wiki home page .............................................................................. 76
Linking pages to a wiki ..................................................................................................... 76
Inserting images ................................................................................................................ 77
Attaching documents ........................................................................................................ 77
Using interwiki links ......................................................................................................... 78
Renaming wiki pages ........................................................................................................ 78
Printing wiki pages .......................................................................................................... 78

9. Automating work processes .......................................................................................... 80
Routing documents ......................................................................................................... 80
Creating a routing task .................................................................................................... 80
Setting up a collection for routing documents ............................................................... 83
Checking the status of routing tasks you assigned ......................................................... 83
Viewing progress reports ............................................................................................... 85
Publishing a new version of your routed document ....................................................... 86
Changing the preferred document version when the review is complete ..................... 87
Viewing the tasks assigned to you .................................................................................. 87
Approving or disapproving a document ......................................................................... 88
Reviewing a document ..................................................................................................... 88
Acknowledging receipt of a document ............................................................................ 89
Removing a document sent for information ................................................................... 89
Viewing your deleted tasks .............................................................................................. 90
Viewing the routing tasks of a document ....................................................................... 90
Workflow Reporting ......................................................................................................... 90
Accessing Workflow Reporting ...................................................................................... 91
Workflow Reporting Search Criteria .............................................................................. 91
Workflow Search Results Page ........................................................................................ 92
Workflow Search Results Column Fields ........................................................................ 92
Workflow Search Results with Multiple Documents & Multiple Approvers ............... 94
Using content rules ......................................................................................................... 94
Creating a content rule ................................................................................................... 95
Changing content rules ................................................................................................. 96
Deleting a content rule ................................................................................................... 97
Managing site content rules ......................................................................................... 97
Copying content rules .................................................................................................... 97
New Content Rules for DocuShare ............................................................................... 98
Auto create Folders with metadata Content Rule ......................................................... 98
Using WebDAV folders

Permissions required for tasks on a site using six permissions
Permissions required for tasks on a site using three permissions

Task Permissions

Permissions required for tasks on a site using three permissions
Permissions required for tasks on a site using six permissions

WebDAV folders

Using WebDAV folders
Document titles in WebDAV folders
1. Introduction

DocuShare product editions

Xerox® DocuShare provides several product editions. Depending on which product edition you are using, certain features and add-ons are available.

**Note:** DocuShare Express is not available in all geographies.

DocuShare documentation describes all product features and add-ons. Refer to the below table to see which features and add-ons are available for your use.

**Product Comparison**

<table>
<thead>
<tr>
<th>Feature</th>
<th>DocuShare Express</th>
<th>DocuShare Education</th>
<th>DocuShare</th>
<th>DocuShare Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Check-in / Check-out and Version History</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Access Permissions</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Expanded Permission Set</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Full Text and Property Indexing and Search</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Notifications</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Change History / Activity History</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Document Routing and Approval</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Side-by-Side Document Content and Property Viewer</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Scan Cover Sheets</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Document Comments</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Weblogs and Wikis</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>HTML Conversion</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Custom Properties Creation</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Custom Object Creation</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Document and Permission Reports</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>LDAP Support</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>WebDAV Support</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>

Xerox® DocuShare® – User Guide 6
## Product Comparison

<table>
<thead>
<tr>
<th>Product Add-ons</th>
<th>DocuShare Express</th>
<th>DocuShare Education</th>
<th>DocuShare</th>
<th>DocuShare Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Connector</td>
<td></td>
<td>Add-on</td>
<td>Add-on</td>
<td>Add-on</td>
</tr>
<tr>
<td>Content Encryption</td>
<td></td>
<td></td>
<td>Add-on</td>
<td>Add-on</td>
</tr>
<tr>
<td>Content Rules Manager (content rules / workspaces features)</td>
<td>Add-on</td>
<td>Add-on</td>
<td>Add-on</td>
<td>•</td>
</tr>
<tr>
<td>Database Connectors</td>
<td>Add-on</td>
<td>Add-on</td>
<td>Add-on</td>
<td>•</td>
</tr>
<tr>
<td>eForms</td>
<td>Add-on</td>
<td>Add-on</td>
<td>Add-on</td>
<td>Add-on</td>
</tr>
<tr>
<td>Email Agent</td>
<td>Add-on</td>
<td>Add-on</td>
<td>Add-on</td>
<td>•</td>
</tr>
<tr>
<td>OCR Service</td>
<td></td>
<td></td>
<td>Add-on</td>
<td>Add-on</td>
</tr>
<tr>
<td>PDF Conversion</td>
<td>Add-on</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Quick Search</td>
<td>•</td>
<td>Add-on</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>
2. Getting started

Overview

The DocuShare family of products allow you to manage electronic content using a web browser easily and efficiently. Using DocuShare, you can create, organize, and share content, collaborate with other users on projects, search for and retrieve content, and automate work processes.

Key features in the products enable you to:
• Create and maintain your own account and personal work area without the assistance of a web master or site Administrator.
• Add and control access to site content.
• Maintain multiple versions of a document, track its revision history, and lock a document to prevent simultaneous editing.
• Collaborate on content using wikis and weblogs.
• Scan paper documents to site locations.
• Route documents for approval or review.
• Create project-oriented areas for managing the content, people, and tasks.
• Set up content rules to automate a work process.

Accessing DocuShare

You access DocuShare by entering the URL of your DocuShare site in a web browser window. Depending on how your site is set up, you may be required to log in or you see the DocuShare home page. From the site home page, you can log in, as well as access the content and features on your site.

Although your Administrator can customize your site home page and different browsers may not display site elements the same, your home page should look like the example displayed below.
The DocuShare home page includes these features:

A. The site’s top-level collections appear on the left side, which your Administrator sets up.

B. Navigation bar, which includes links to frequently used pages and a search area for running simple searches and accessing advanced search features.

C. Other links, which include My DocuShare, Content Rules Management, Workflow Reporting and Lifecycle Manager policies, and other features in the center, if available.

D. Page footer, which includes links to other DocuShare pages and help information.

E. Access to community areas and workspaces on the right.

F. What’s New menu, which you can use to see the content that has been recently added or changed.

DocuShare provides a feature called spaces, which enables your Administrator to separate users and content within distinct areas on your site. This provides your organization with greater control over access to content and offers customization capabilities for each space. All the features your Administrator set up for DocuShare are available within each space; you access and use these features the same, regardless of whether you are in a space or not.

If your Administrator created spaces on your site and added you as a member of one or more spaces, a Go to menu appears below the navigation bar. The menu lists the spaces you can access. For more information on how to use spaces, see DocuShare workspaces.

Navigating DocuShare

DocuShare navigation features make it easy to find what you need.
Navigation bar—Includes links to pages and features that are used frequently:

- Home—returns to the home page.
- My DocuShare—displays your personal home page, which includes your favorites, a personal collection, calendar and more. The link displays after you log in and on pages other than the DocuShare home page.
- My Tasks—opens in a new window to display the routing tasks assigned to you and the tasks you assigned. The link displays after you log in.
- My Favorites—opens in a new window to display items you have added to the list.
- Recent—lists the new and changed objects on your site.
- Search area—includes an area for running simple searches as well as a link to the Advanced Search page.
- Username—displays your user account properties. Your username displays after you log into DocuShare.
- Logout—logs you out of DocuShare. The link displays after you log in.

Page footer—Provides links to related information and:

- Users & Groups—Provides links to listing, finding, and creating user and group accounts.
- Help—provides access to user guides, tutorials, and software downloads.
- Content Map—a hierarchical display of the objects on your site, based on your current location. You can click any object in the Content Map to open it. Depending on how your site is set up, this link may not appear.

Breadcrumbs—Provide a path from the home page to your current location or list the last few pages you visited. You can click any link in the breadcrumbs to go to the page.

Location: Home \ Initial Top Level Collection D \ My Collection Listing

Logging in and out

Your Administrator determines the access policies for your site. Therefore, you may be able to browse and view content without logging in (as a guest) or you may be required to log in before you can access any site content.

To log into DocuShare:

1. In a web browser, enter the URL of your DocuShare site.
2. In the Login area, enter your registered username and password in the fields.
   - Your password is case-sensitive.
3. In the Domain field, select your internal domain name (if applicable).
4. If the Retain login for future checkbox appears, click it if you want your username and password to be retained. This makes logging into DocuShare easier in the future.

   **Note:** The Retain login for future checkbox only appears if your Administrator has configured your site to allow users to do this.

5. Click Login.
   - Your username appears on the navigation bar, indicating that you are logged in.

To log out of DocuShare:
1. Do one of the following:
   – Close the browser window.
   – Click the **Logout** button on the navigation bar.

**How to get help**

In addition to this guide, the Help Desk includes other guides and a tutorial. The Documentation page provides user guides for the features available on your site. The Training page includes a User Tutorial, which helps you get started using DocuShare by following a series of step-by-step exercises.
3. Managing accounts

About accounts

DocuShare provides two types of accounts: individual user accounts and group accounts. Your Administrator determines who can create each type of account on your site. For example, your site might allow a guest (someone who can view public content) to create a user account but require an Administrator to create group accounts.

When a user account is created, either by you or an Administrator, it is assigned a user level. The user level controls the level of access to site content and functions. One of the following user levels is specified when creating a user account:

• Read-Only—Allows the user to view content and manage personal content on My DocuShare.
• DocuShare—Allows the user to access all DocuShare content management functions.
• CPX—Allows the user to access all DocuShare CPX content and process management functions.

After the user account is created, the user level assigned to the account is indicated by the superscript letters appearing after the username: read-only, DS, or CPX.

Note: If your site uses the LDAP (Lightweight Directory Access Protocol) feature to manage user accounts, an Administrator creates an account for you. To find out how your site is configured, see your DocuShare Administrator.

User accounts

To add and edit content, you must have a DocuShare user account.

Creating a user account

If your site allows a guest to create accounts, you can create a user account. If account creation is restricted, an Administrator needs to create a user account for you.

To create a user account:

1. On the page footer, click Users & Groups.
2. Click the Add User link.
3. On the Add User page, enter the following information:
   Username—The name used to log into DocuShare.
   Password and Password Confirm—The password used to log into DocuShare. Your Administrator can specify that passwords adhere to a set of rules. If specified, the rules appear on the page.
Passwords are case-sensitive and must be typed as specified when logging in.

**Domain**—An organization or other entity on your DocuShare site. The menu lists internal domains only.

**User Level**—The level of access to site content and functions.

**Last Name**—The last name of the user. Users are listed on the DocuShare site by their first and last names.

4. Enter any optional information. Click a field name for a description of each property.

   **Note:** If your Administrator created custom properties, they also display on the page. See your Administrator for information about custom properties.

5. Click **Apply**.

   The View Properties page for the user account appears.

   If DocuShare was unable to create a new account, a message page appears describing the problem.

### Viewing user account properties

You can view the properties of any DocuShare user account.

To view a user’s account properties:

1. Locate and select the user whose properties you want to view. To search for a user, see **Finding and listing site accounts**.
   
   The View Properties page appears, displaying the user’s properties. Click a field name for a description of each property.

### Changing your user account properties

Another user can view, but not change, your user account properties. To change your user account properties, you must first log in.

To change your user account properties:

1. On the navigation bar, click your username.
2. On the View Properties page, click the **Edit** link.
3. Change the properties you want. Click a field name for a description of each property.
4. Click **Apply**.

### Changing your password

To change your password, you must first log in. Another user cannot change your password.

**Note:** If your site uses the LDAP feature, you cannot change your password. Your Administrator must change your password on the LDAP server.

To change your current password:
1. On the navigation bar, click your username.
2. On the View Properties page, click the Change Password link.
3. Enter your current password in the Old Password field.
4. Enter your new password in the New Password field.
   Your Administrator can specify that passwords adhere to a set of rules. If specified, the rules appear on the page.
5. Enter your new password in the New Password Confirm field.
6. Click Apply.

Changing your username

To change your username, you must first log in. Another user cannot change your username.

Note: If your site uses the LDAP feature, you cannot change your username. Your Administrator must change your username on the LDAP server.

To change your username:
1. On the navigation bar, click your username.
2. On the View Properties page, click the Change Username link.
3. Enter your current password in the Password field.
4. Enter a new username in the Username field.
5. Click Apply.
   The View Properties page appears displaying your new username. The new name also appears on the navigation bar.

Viewing your usage quotas

Your Administrator can restrict the number of documents that you own as well as the maximum size allocated to all your documents. You can view your quotas and your current usage.

Note: Documents include email attachments and documents attached to discussion topics and wiki pages.

To view your usage quotas:
1. On the navigation bar, click your username.
2. On the View Properties page, click the Quotas link.
   If set, the page displays your quotas.
   Note: When Not set (default to highest group setting) is used, DocuShare checks the quotas assigned to all the groups you are a member of and uses the highest. If none of the groups have quotas set, then your quotas default to unlimited.
3. To view your current usage, click the Show Quota Usage button.
The meters display your current usage information.

Should you exceed your usage quotas, you receive an error message when you try to add another document to your site. Contact your Administrator should this occur.

**Changing your domain**

If your site uses domains, you can change to another internal domain on DocuShare. You must be logged in as the user whose domain you want to change. You cannot change another user’s domain.

To change your current domain:
1. On the navigation bar, click your username.
2. On the View Properties page, click the **Change Domain** link.
3. Select a new domain from the **Domain** menu.
4. Click **Apply**.

**Selecting a theme**

Themes let you personalize the look of your DocuShare site. Four predefined themes are provided; each changes the color scheme used on site pages.

To select a theme:
1. On the navigation bar, click your username.
2. On the View Properties page, click the **Themes** link.
3. Select a theme.

   **Note:** If you choose to not use a theme, the default theme is used.

4. Click **Apply**.

**Viewing your activity history**

DocuShare keeps track of all user activity on your site, which provides an audit trail of the actions of each user. You can view your site activity only. An Administrator can view the activity of all site users.

Your Administrator determines whether the activity history feature is enabled on your site.

To view activity history:
1. Click your username on the navigation bar.
2. On the View Properties page, click the **Activity History** link.
3. From the **Activity** menu, select the type of activity you want to view.
4. From the **Object Type** menu, select an object to limit the activity displayed to a specific object type.
5. From the **Show Last** menu, select the number of activity events to display.
6. To display the activity during a specific date range, enter start and end dates.

7. Click Go.

Information about the activity displays. You can click Show as XML to convert the information to Extensible Markup Language (XML) format for use with other applications.

Deleting a user account

Only an Administrator can delete an existing user account. Contact your Administrator if you want to delete your user account. If you have several user accounts, your Administrator can combine any number of the accounts into one account.

Group accounts

A group consists of any number of DocuShare users, groups, or both. When your site includes groups, you can more easily manage access to objects by assigning permissions to the group instead of to each user.

Creating a group

The DocuShare Administrator can choose to allow logged-in users to create group accounts or to have group account creation under administrative control. If after logging into DocuShare, you do not see the Add Group link on the Users and Groups Registry page, then an Administrator needs to create a group for you.

To create a group:

1. On the page footer, click Users & Groups.
2. Click the Add Group link.
3. In the Title field, enter a name for the group. The name can contain spaces and punctuation marks and can be identical to another group name.
4. In the Domain field, select the name of a domain. The menu lists internal domains only.
5. In the Spam Control field, select either No Restriction, Registered Users Only or Group Members Only.
6. Enter any optional information. Click a field name for a description of each property.

   Note: If your Administrator created custom properties, they also display on the page. See your Administrator for information about custom properties.

7. Click Apply.

The Pick Members for Group page appears.

8. In the Show field, select the type of account you want to display in the Possible Users/Groups field.

9. Do one of the following:

   – To find a specific account, enter part of the user’s first name, last name, or username or the group’s title in the Search field. Click the Go button.
To list all accounts, click **Show All** (if displayed).

To display your favorite accounts, click **Show Favorites**.

10. In the **Possible Users/Groups** field, select the accounts to add to the group and click the **Add** button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

11. In the **Selected Users/Groups** field, select any accounts that you want to remove from the group and click the **Remove** button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

12. Click **Update**.

   The group members display on the Members page.

13. To give one or more members manage permission to the group, click the checkbox next to each member’s name and click **Apply**. Manage permission allows the member to change the group’s properties and membership.

### Viewing group properties

You can view the properties of any DocuShare group.

To view a group’s properties:

1. Locate and select the group whose properties you want to view. To search for a group, see **Finding and listing site accounts**.

   The View Properties page for the group appears. Click a field name for a description of each property.

### Changing group properties

Depending on how the group was set up, either the logged-in owner of the group or a logged-in group member can change the properties of a group.

To change a group’s properties:

1. Locate and select the group whose properties you want to change. To search for a group, see **Finding and listing site accounts**.

2. On the View Properties page, click the **Edit** link.

3. Change the properties that you want. Click a field name for a description of each property.

4. Click **Apply**.

### Viewing the usage quotas for a group

Your Administrator can restrict the number of documents that each group member can own as well as the maximum size allocated to all the documents. You can view the quotas assigned to a group.

**Note:** Documents include email attachments and documents attached to discussion topics and wiki pages.

To view the usage quotas for a group:
1. Locate and select the group whose usage quotas you want to view. To search for a group, see Finding and listing site accounts.

2. On the View Properties page, click the Quotas link.
   If set, the page displays the quotas.

   **Note:** Any quotas set for a user take precedence over the quotas set for a group the user is a member of.

### Changing the members of a group

Depending on how the group was set up, either the logged-in owner of the group or a logged-in group member can change the members of the group.

To change a group's members:

1. Locate and select the group whose members you want to change. To search for a group, see Finding and listing site accounts.

2. On the View Properties page, click the Members link.
   The Members page displays the current group members.

3. To change group members, click the Change Membership button.

4. In the Show field, select the type of account you want to display in the Possible Users/Groups field.

5. Do one of the following:
   - To find a specific account, enter part of the user’s first name, last name, or username or the group’s title in the Search field. Click the Go button.
   - To list all accounts, click Show All (if displayed).
   - To display your favorite accounts, click Show Favorites.

6. In the Possible Users/Groups field, select the accounts to add to the group and click the Add button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

7. In the Selected Users/Groups field, select any accounts that you want to remove from the group and click the Remove button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

8. Click Update.
   The group members display on the Members page.

### Changing the owner of a group

Only the logged-in owner of the group can change its owner. After changing the group’s owner to another user, you can no longer change the group’s members and properties, unless you have manage permission to the group.

To change the owner of a group:

1. Locate and select the group whose owner you want to change. To search for a group, see Finding and listing site accounts.
2. On the View Properties page, click the Edit link.

3. Click Change Owner.

   The Change Owner page appears.

4. Do one of the following:
   – To find a specific user account, enter part of the user’s first name, last name, or username in the Search field. Click the Go button.
   – To list all user accounts, click Show All (if displayed).
   – To display your favorite accounts, click Show Favorites.

5. Select a name from the New Owner field.

6. In the Add Owner to Group field, click Yes to add the new owner to the group.

7. Click Update Owner.

Changing the domain of a group

If your site uses domains, you can change a group’s domain to another internal domain on DocuShare. You must be the logged-in owner of the group to change its domain.

Note: Changing the group's domain does not change a group member's domain, if one is used.

To change a group’s domain:
1. Locate and select the group whose domain you want to change. To search for a group, see Finding and listing site accounts.
2. On the View Properties page, click the Change Domain link.
3. Select a new domain from the Domain menu.
4. Click Apply.

Sending mail to group members

To easily communicate with a DocuShare group, you can send an email message to the group’s members. The message is sent to each member whose user properties include an email address. To send email, your web browser must be correctly configured with a mail client, such as Microsoft Outlook.

To send email to the members of a group:
1. Locate and select the group that you want to send an email message to. To search for a group, see Finding and listing site accounts.
2. On the View Properties page, click the Email link.
3. To write your message, click the here link.

   Your browser launches an untitled message window with each group member’s email address entered in the To field.

4. Compose your message and click Send to email the message to the members of the group.
Viewing the change history

DocuShare keeps track of all the changes to site objects, which provides an audit trail of the changes to objects.

To view the change history:
1. Locate and select the group whose change history you want to view. To search for a group, see Finding and listing site accounts.
2. On the View Properties page, click the Change History link.
3. From the Change menu, select the type of change you want to view.
4. Do one of the following:
   - Enter part of a name in the Search for User field and then choose the user from the Select User menu.
   - If displayed, click Show All and then choose the user from the Select User menu.
   - Choose All from the Select User menu.
5. From the Show Last menu, select the number of change events to display.
6. To display the activity during a specific date range, enter start and end dates.
7. Click Go.
   Information about the change displays. You can click Show as XML to convert the information to Extensible Markup Language (XML) format for use with other applications.

Deleting a group

You can delete a group if you are the logged-in owner of the group.

To delete a group:
1. Locate and select the group that you want to delete. To search for a group, see Finding and listing site accounts.
2. On the View Properties page, click the Delete Group link.
   The Confirm Delete page appears.
3. Click Delete to remove the group from your site.

Finding and listing site accounts

From the User and Group List page, you can quickly search the users and groups registry to determine whether a user or group has an account on the DocuShare site. You also can list all of the user and group accounts registered on the site.

To search for a user or group:
1. On the page footer, click Users & Groups.
2. On the User and Group List page, select the type of account you want to find in the Show field.

3. When searching for a user, you can filter the results by selecting a single user level or all levels from the User Level menu. You can also filter by active or inactive status and domain.

4. In the Search field, enter any part of a username or group title.

5. Click Go.

   The search results display, listing the users, groups, or both who match the search text and the filters you set.

To list the accounts on your site:

1. On the User and Group List page, select the type of account you want to list in the Show field.

2. Click Show All (if displayed).

   The list of all registered accounts displays.

When displaying the list of accounts as a CPX user, the User and Group List page enables you to see which users are logged into DocuShare. The user icon next to the user’s name indicates whether or not the user is logged in; the icon is grayed when the user is not logged in.
4. Adding and managing content

About DocuShare objects

You create content on your site by adding different types of DocuShare objects. You organize site content in container objects called collections. Using the CPX feature, you manage the content and resources associated with projects in objects called workspaces. Objects that you can add to collections and workspaces include documents, collections, calendars, discussions, weblogs, wikis, and URLs.

DocuShare identifies each object on your site with a unique handle (for example, Document-37 and Calendar-102). The type and number of objects on your site are dependent on your organization’s needs.

Each DocuShare object is indicated by an icon.

**DocuShare icons**

<table>
<thead>
<tr>
<th>DocuShare object and its icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="User" /> User—A registered DocuShare user.</td>
<td>Group—One or more DocuShare users, groups, or both.</td>
</tr>
<tr>
<td><img src="image" alt="Collection" /> Collection—A container for storing DocuShare objects.</td>
<td>Document—A document stored on the DocuShare site. The icon can vary, depending on the document’s file type.</td>
</tr>
<tr>
<td><img src="image" alt="Document Storage Workspace" /> Document Storage Workspace—A collaborative workspace for a document-intensive project.</td>
<td>Team Project Workspace—A collaborative workspace for a team project. It includes a calendar and a collection for online meeting URLs.</td>
</tr>
<tr>
<td><img src="image" alt="Wiki" /> Wiki—A collaborative web site.</td>
<td>Weblog—A simple web site for frequent postings.</td>
</tr>
<tr>
<td><img src="image" alt="Discussion" /> Discussion—An online forum where topics can be posted.</td>
<td>Topic—A posting to a discussion.</td>
</tr>
<tr>
<td><img src="image" alt="Calendar" /> Calendar—An online monthly or weekly calendar.</td>
<td>Event—A calendar entry.</td>
</tr>
<tr>
<td><img src="image" alt="Mail Message" /> Mail Message—An email message.</td>
<td>Saved Query—Saved search query terms that can be used for a search.</td>
</tr>
</tbody>
</table>
DocuShare icons

<table>
<thead>
<tr>
<th>DocuShare object and its icon</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification—Email notification after a change occurs to a specified object.</td>
<td>Content Rule—A configurable rule for running an action after a change occurs to a specified object.</td>
</tr>
<tr>
<td>URL—An Internet address for a web page.</td>
<td></td>
</tr>
</tbody>
</table>

Object permissions

Every DocuShare object has an access list, which identifies the users and groups who have permissions to the object and the type of permission each account has. The type of permission controls what a user can do with the object.

Depending on how your Administrator set up your site, either three or six permissions are available for use. In addition, you can control who can see an object in a search results list. The table below provides a description of each permission.

Permissions

<table>
<thead>
<tr>
<th>Three Permissions</th>
<th>Six Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reader</strong> allows the user or group to read the content of the object and view its associated properties and permissions.</td>
<td><strong>Read Properties</strong> allows the user or group to view the object’s properties and permissions.</td>
</tr>
<tr>
<td><strong>Writer</strong> allows the user or group to change the object’s properties and add new objects, including new versions of documents.</td>
<td><strong>Read Content</strong> allows the user or group to read the content of the object.</td>
</tr>
<tr>
<td><strong>Manager</strong> allows the user or group to delete the object and change the object’s permissions and owner.</td>
<td><strong>Read History</strong> allows the user or group to view the object’s change history.</td>
</tr>
<tr>
<td></td>
<td><strong>Write Properties</strong> allows the user or group to change the object’s properties.</td>
</tr>
<tr>
<td></td>
<td><strong>Write Content</strong> allows the user or group to add new objects, including new versions of documents, and change the object, such as its location.</td>
</tr>
<tr>
<td></td>
<td><strong>Manage</strong> allows the user or group to delete the object and change the object’s permissions and owner.</td>
</tr>
</tbody>
</table>

Task Permissions details the type of permission required for each object task.
Adding objects

You can add an object to your site if you are logged in and have the required permission to the container. You can add any type of object to collections and workspaces. You can add events to calendars and topics to discussions.

To add an object:

1. Navigate to and open the container to which you want to add an object.
2. From the Add menu, select the type of object that you want to add.
   The Add page appears.
3. In the Title field, enter a name for the object. The name should be short, but descriptive, and can contain spaces and punctuation marks.
4. Enter any additional required information as well as optional information. Click a field name for a description of each property.
   **Note:** If your Administrator created custom properties, they also display on the page. See your Administrator for information about custom properties.
5. Click Apply.
   The object is added to the container.
   For more information on adding documents, see Adding a document. For more information on adding discussions, weblogs, and wikis, see Using social computing features.

Selecting the objects that appear in the Add menu

You can control what type of objects users can add to your collections by adding or removing items from the Add menu.

To modify the Add menu:

1. Navigate to the collection that you want to change.
2. Click the collection’s Properties icon.
3. On the View Properties page, click the Add Menu Objects link.
4. On the Add Menu Objects page there is a list of the possible objects that can appear in the Add menu. Select the ones that you want to appear in the Add menu. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).
5. Click Apply.
6. Navigate back to your collection listing and click the Add menu. Only the objects you selected appear in the menu.
Viewing objects in containers

When viewing objects in a collection or events in a calendar, you can change how the objects are displayed in the container. In addition, you can control the number of objects to display per page.

You can display a collection in any of the following views:

- **List view**—Displays objects in a list. It is denoted as an icon of 4 stacked lines.
- **Images view**—Displays image files as thumbnails and all other object types as large icons.
- **Email view**—Displays the properties associated with email messages. It is denoted as an envelope icon.

As well, DocuShare also provides a **Change View Options** function (icon is standing lines enclosing arrows located in the gray banner) that provides collection controls for defining the properties used in the collection headers.

A View Options window appears with Available properties on the left and Visible properties on the right. Available properties can be added to properties visible in the collection heading by selecting the property and selecting the > (greater than) icon. A Visible property is removed by selecting the property and selecting the < (less than) icon. Except for default properties, the chosen Available properties display in the right column as Object(property), such as Document(Filename). Possible Objects are Global Properties, Collection, Document, URL, Discussion, Calendar, SavedQuery, MailMessage, Weblog, Wiki.

Single and multiple properties can be selected using Ctrl and Shift keys. Once selected, properties are highlighted. Once moved, the property displays a check mark before it. When added to Visible, the property can be ordered using ^ or v icons. The ordered list from top to bottom correspond to left to right heading order.

**APPLY (FOR ME)** or **SAVE AS DEFAULT FOR ALL USERS** set the collection for viewing specific for the user or to all users. This closes the window.

You can display a calendar in any of the following views:

- **Month view**—Use the 31 button to display an entire month with the current day highlighted. From the current month, you can click a link for the previous month and the next month. You can also display calendars for previous and following years.
  The start time and title of each calendar event is displayed on the date to which it was added.
- **Week view**—Use the 7 button to display an entire week with the current day highlighted. From the current week, you can click a link for the previous week and the next week. You can also display calendars for previous and following years.
  The duration, title, and owner of each event is displayed on the date to which it was added.
- **Day view**—Use the 1 button to display the current day. From the current day, you can click a link for the previous day and the next day. You can also display a day from another month or year.
  The day view displays the duration, title, and owner of each event added to the date.

To set the number of objects to display per page:

1. On the navigation bar, click your username.
2. On the View Properties page, click the **Edit** link.
3. In the **Page Size** field, enter the number of objects you want to view on pages with object listings (for example, collections and search results).
4. Click **Apply**.
Viewing and changing object properties

Every object has a set of assigned properties. For example, the properties for all objects include a title, a description, and an owner. Each object has several specific properties. For example, the sort order property is unique to collections and documents have a maximum versions property. Your DocuShare Administrator also can create custom properties for use at your site. You can assign property values to objects, which allows you to categorize objects, provide information about objects to other users, and facilitate searches.

To view and change the properties of an object:

1. Locate the object whose properties you want to view and change.
2. Click the object’s Properties icon.
3. On the View Properties page, click the Edit link.
4. Change the properties you want. Click a field name for a description of each property.
   
   **Note:** If your Administrator created custom properties, they also display on the page. See your Administrator for information about custom properties.

5. Click Apply.

Viewing the change history

DocuShare keeps track of all the changes to site objects, which provides an audit trail of the changes to objects. Your Administrator determines whether or not the change history feature is enabled on your site.

To view the change history:

1. Locate the object whose change history you want to view.
2. Click the object’s Properties icon.
3. On the View Properties page, click the Change History link.
4. From the Change menu, select the type of change you want to view.
5. To filter the change history results, do one of the following:
   
   – To view the changes a user made, enter part of the user’s name in the Search for User field and then choose the user from the Select User menu.
   
   – Click Show All (if displayed) and then choose the user from the Select User menu.
   
   – Choose All from the Select User menu.
6. From the Show Last menu, select the number of change events to display.
7. To display the activity during a specific date range, enter start and end dates.
8. Click Go.

Information about the change displays. You can click Show as XML to convert the information to Extensible Markup Language (XML) format for use with other applications.
Multiselect View

The Multiselect view displays a popup view, over the Collection View page, to display documents and their properties in a side-by-side view. The document can be a standard or a custom object.

View a Document

To view a document in the Multiselect View:

Select the document to display in a side-by-side view. Note that more than one file can be selected at a time.

From the Edit Selected … menu, select Multiselect View.

While loading the feature, the message: Loading, Please wait… is displayed.

The top of the window displays Previous and Next document controls, as well as Selected Document number of total selected if multiple documents are chosen.

The right frame displays a top banner containing the name of the file, the 'current page'/total page count indicator, a rotate control, a download control, and a print control. Below the banner, the current page is displayed. Controls on the image include maximize (frame icon), enlarge (+), and reduce (-). A scroll bar also allows the user to scroll the length of the document.

If a document or an object cannot be displayed in the document viewer, the right frame displays with a message: No Preview Available.

Edit and View Properties

The left frame displays the file name in the top banner, along with a window containing Edit Properties tab where the properties of the documents can be edited. A View Properties tab allows the user to view the document properties.

For Edit properties, the bottom of the window displays UPDATE and CLOSE control buttons.

For View Properties, the bottom of the window displays the CLOSE control button.

Generating object reports

From a collection listing or a Search Results page, you can generate an object report by exporting DocuShare property information. Your Administrator determines which properties display in the report. The generated report is in tab-separated values format, which enables you to open the report in a spreadsheet application.

To generate an object report from a collection listing:

1. Open the collection that contains the objects that you want detailed in the report.
2. To select individual objects, click the checkbox next to each object.
   
   **Note:** Do not click any checkboxes if you want all the objects in the report.

3. From the Edit Selected menu, select Generate Report.
4. In the file download window, choose the option to save the report.

To generate an object report from a Search Results page:

1. Run a search to find the objects that you want in the report.
2. To select individual objects, click the checkbox next to each object.
   
   **Note:** You can click the checkbox to the left of the Type column heading to select all the objects. If there are multiple search pages, select Show All from the Show menu first.

3. From the Edit Selected menu, select Generate Report.
4. In the file download window, choose the option to save the report.

## Managing access to objects

When you add an object to your site, you set the object’s initial permissions. As the user who added the object, you are its owner and have full permission to it. As needed, you can change the users and groups in the access list and the type of permissions each user or group has.

Depending on how your Administrator set up your site and if you are a CPX user, colored key icons may appear next to objects indicating who can access the objects. You can click the **key** icon next to an object to display its Permissions page.

### Permission icons

<table>
<thead>
<tr>
<th>Permission icon and its description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green key—Indicates that the object can be accessed by anyone.</td>
</tr>
<tr>
<td>Yellow key—Indicates that the object can be accessed by one or more groups.</td>
</tr>
<tr>
<td>Gray key—Indicates that the object can be accessed by individual users.</td>
</tr>
</tbody>
</table>

### Viewing the access list of an object

To view an object’s access list:

1. Locate the object whose access list you want to view.
2. From the object’s More Actions menu, select Permissions.
   
   The Permissions page displays the users and groups in the access list and the permissions each account is assigned.

### Changing the access list of an object

To change an object’s access list
1. Locate the object whose access list you want to change.

2. Do one of the following:
   – From the object’s More Actions menu, select Permissions.
   – If displayed, click the key icon that appears to the right of the object’s title.

   The Permissions page for the object appears.

3. For **Search Available To**, do one of the following:
   – Click Anyone to allow guests and users to view the object in a search results list.
   – Click Access List Only to allow only those accounts in the object’s access list that have at least Reader or Read Properties permission to see the object in a search results list.

4. If you want to change the list of users and groups who have access to the object, click the Change Access List button.

   The Change Access List page appears.

5. In the **Show** field, select the type of account you want to display in the Possible Users/Groups field.

6. Do one of the following:
   – To find a specific account, enter part of the user’s first name, last name, or username or the group’s title in the Search field. Click the Go button.
   – To list all accounts, click Show All (if displayed).
   – To display your favorite accounts, click Show Favorites.

7. In the Possible Users/Groups field, select the accounts to add to the access list and click the Add button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

8. In the Selected Users/Groups field, select any accounts that you want to remove from the access list and click the Remove button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

9. Click Update Access List.

   The Permissions page appears, displaying the new access list.

10. Check the permission boxes you want for each user and group displayed in the access list.

11. Click Apply.

**Note:** When you change the access list and permissions of an object, the change occurs in the background. A link to your background jobs appears under the navigation bar; you can click the link to check the status of and delete background jobs.

### Changing the owner of an object

The default owner of an object is the user who initially created the object.

To change the owner of an object

1. Locate the object whose owner you want to change.

2. Do one of the following:
– Click the checkbox that appears to the left of the object’s title. From the Edit Selected menu, select Change Owner. On the confirmation page, click Confirm.

– From the object’s More Actions menu, select Permissions. On the Permissions page, click the Change Owner button.

The Change Owner page appears.

3. Do one of the following:
   – To find a specific user account, enter part of the user’s first name, last name, or username in the Search field. Click the Go button.
   – To list all accounts, click Show All (if displayed).
   – To display your favorite user accounts, click Show Favorites.

4. Select a username from the New Owner field.

5. If the object is a document, see Applying permissions to a document and its versions.

6. If the object is a collection, see Applying permissions to the objects in a container.

7. Click Update Owner.

   The Permissions page for the object appears, displaying the name of the new owner at the top of the access list. The new owner has full permissions.

   The name of the previous owner remains in the access list.

Applying permissions to the objects in a container

When you change the permissions of a container that includes objects, you can choose how to apply the container’s permissions to its contents. You can choose to apply all of the permissions or only the changed permissions to either the container or the container and its contents.

To apply a container’s permissions to the objects in it:

1. Locate the container whose permissions you want to change.

2. From the container’s More Actions menu, select Permissions.

   The Permissions page for the container appears.

3. Make the changes you want to the access list.

4. For Options, select one of the following:
   – Apply all permissions to—Assigns all the access permissions.
   – Apply only changes to—Assigns only the changed access permissions.

5. Select one of the following:
   – This container only—Applies the permissions to the container only. The permissions of the container’s objects are not changed.
   – This container and its objects, including objects that appear in multiple locations—Applies the permissions to the container and the objects in it. The permissions of the same objects that appear in other containers also are changed.
– This container and its objects, excluding objects that appear in multiple locations.—Applies the permissions to the container and the objects in it. The permissions of the same objects that appear in other containers are not changed.

6. Click Apply.

Applying permissions to a document and its versions

Each version of a document has its own access list. Therefore, when you change a document’s permissions you can choose how you want to apply the changes to the document’s versions.

To apply a document’s permissions to its versions:
1. Locate the document whose permissions you want to change.
2. From the document’s More Actions menu, select Permissions.
   The Permissions page for the document appears.
3. Make the changes you want to the access list.
4. For Apply all permissions to, select one of the following:
   – This document and its versions—Assigns the changed permissions to the document and all its versions.
   – This document only—Assigns the changed permissions to the document only. The document and its versions have different access permissions.
5. Click Apply.

Changing the location of objects

You can move an object to another container or have the object appear in several containers on your site. Although an object can appear in several containers, there is only one copy of it, which saves space on your DocuShare site.

Note: You can also use the Copy, Cut, and Paste commands from the Edit Selected menu to change the location of a collection. See Using Copy, Cut, and Paste to change the location of an object.

To change the location of an object:
1. Locate the object whose location you want to change.
2. Do one of the following:
   – Click the checkbox that appears next to the object’s title. From the Edit Selected menu, select Change Location. On the Confirm Change Location page, click Confirm.
   – Click the Properties icon that appears to the right of the object’s title. On the Properties page for the object, click the Locations link.
   The Change Location page appears.
3. In the Sort By field, select Title to display the possible containers in alphabetical order or select Handle to display the possible containers in numerical order.
4. Do one of the following:
   – To find specific containers, enter any part of a container title in the Search field. Click the Go button.
   – To list all containers, click Show All (if displayed).
   – To display your favorite containers, click Show Favorites.

5. In the Possible Locations field, select the containers in which you want the object to appear and click the Add button. To select multiple containers, use the Ctrl key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any containers in which you do not want the object to appear and click the Remove button. To select multiple containers, use the Ctrl key (Windows) or the Command key (Macintosh).

   **Note:** Make sure at least one container appears in the Selected Locations field. Otherwise, the object becomes orphaned, which means it does not appear in any container.

7. Click Update Locations.

**Using Copy, Cut, and Paste to change the location of an object**

To copy or cut objects:

1. Locate the object that you want to copy or cut.
2. Click the checkbox next to the object.
3. From the Edit Selected menu, select either Copy or Cut.
   A confirm window appears.
4. Choose whether to remove any objects from the clipboard before the copy or cut.
5. Click Confirm.

   **Note:** When using the Cut command, the object title is faint until you Paste it to another container.

6. Open the container in which you want to paste the object.

   **Note:** To paste a workspace, open the workspace in which you want to paste the object and then click Content Map.

7. From the Edit Selected menu, select Paste.
   A confirm window appears.
8. Choose whether to remove any objects from the clipboard after the paste.
9. Click Confirm.
   The object appears in the container.
Copy Template as a Web Function

DocuShare supports a copy/paste function in its standard web user interface which adds location and does not create copies of objects. Copy/Paste Template copies truly by creating objects, with preservation of permissions and properties, if set in Copy Paste Template Configuration Administration page.

The User Interface Copy Template allows the user to explicitly copy from a source location, then paste to a destination location, duplicating the template objects. The availability of the Template Paste tool may be limited to members of a defined DocuShare group.

To use the Copy Template feature, within a Collection, the user selects a collection and then chooses Copy Template in the Edit Selected Menu. Once Copy Template is selected, the confirmation page displays a Confirm Copy/Paste Template page, with the selected collection checked, and button control choices for the user to either Confirm and Select Destination Collection or Cancel.

After the user selects and confirms the template to be selected, the user is sent to the Home Page so that he can select the destination where he wants to paste the template.

If no object is selected before selecting Copy Template in the Edit Selected menu, a Copy/paste template Error message is displayed stating that the user has not selected any template to copy. It directs the user to select the Back button and select a Collection to be copied as a template.

If an object other than a standard or custom Collection is selected, a Copy/paste template Error displays stating that the user has selected an object other than a Collection to be used as a template. It directs the user to select the Back button and select a Collection to be copied as a template.

Additional Notes on the Copy Template feature:

• Invoking the Template Paste tool inserts a copy of the template in the chosen/current collection. New objects are created, unlike DocuShare copy/paste.
• Permissions on all newly created objects can be copied from the template – no inheritance, if set in Copy Paste Template Configuration Administration page.
• Properties on all newly created objects are copied from the template, if set in the Copy Paste Template Configuration Administration page.
• Modification of templates have no impact on existing copies.
• Only copying of Collections, Documents, URL, Calendar, Subscription, MailMessage and SaveQuery is supported by this version of Copy Paste Template Tool.
• Only the last version of Document is copied.
• If a Standard object is selected to be copied in configuring the content rule or in the Copy Paste Template Configuration Administration page, only standard object is copied. To copy custom object, one needs to specifically select that custom object.
• The template cannot be copied in the same hierarchy as the source.
• Even when Collection is not selected for the object to be copied, the source collection is copied, if ‘Include Source Collection while copying’ is selected.

Copy Template can also be invoked as a Content Rule. See New Content Rules for DocuShare.

Editing multiple objects in a collection

When viewing an open collection, you can use the Edit Selected menu to perform a variety of tasks on one or more objects. The menu includes these commands:

• Add to Favorites—Add the object to Favorites on My DocuShare.
• **Change Location**—Add the object to another location.
• **Change Owner**—Change the owner of the object.
• **Copy**—Copy a reference of the object to the clipboard. You have the option of clearing the objects on the clipboard before you copy your selected objects. The clipboard can contain a maximum of 100 objects.
• **Copy Shortcuts**—Copy a reference of the object to the clipboard so it can be pasted to a shortcuts portlet on a workspace. You have the option of clearing the objects on the clipboard before you copy your selected objects.
• **Cut**—Cut the object to the clipboard. You have the option of clearing the objects on the clipboard before you cut your selected objects. The clipboard can contain a maximum of 100 objects.
• **Copy Template**—Allows the user to duplicate template objects by explicitly copying them from a source location to a destination location, without creating copies of objects and with preservation of the permissions and properties.
• **Paste**—Paste the object from the clipboard (command appears when an object has been copied or cut to the clipboard).
• **Paste (Move) to Space**—Paste the object from the clipboard to a space or the main DocuShare site (command appears if your site uses spaces and when an object from a space or the main DocuShare site has been cut to the clipboard). See DocuShare workspaces for more information.
• **Delete**—Remove the object from your site.
• **Rename**—Change the title of the object.
• **Route**—Send the document to users for approval, review, or information. See Automating work processes for more information.
• **Send to DocuSign**—If DocuSign connector is integrated, allows user to send a chosen object to DocuSign for processing.
• **Multiselect View**—Displays a popup view, over the Collection View page, to display documents and their properties in a side-by-side view. The document can be a standard or a custom object.
• **Generate Report**—Exports DocuShare property information to a report. See Generating object reports for more information.
• **Zip and Download**—Download documents and collections by first zipping them.

To edit multiple collection objects:

1. Navigate to and open the collection.
2. Do one of the following:
   - To edit some of the objects, click the checkbox next to the objects you want.
   - To edit all the objects, click the checkbox to the left of the **Type** column heading.
3. From the **Edit Selected** menu, select the command you want.
   
   A confirm window appears.
4. Click **Confirm** to continue. Depending on which command you selected, additional pages may appear.

**Note:** When using the **Change Location** command, if an object appears in more than one collection, only the current collection is listed in the **Selected Locations** field.
Deleting objects

DocuShare provides both a site-wide trashcan and a personal trashcan for each user. Your Administrator determines which trashcans are used on your site. If your site uses both the site-wide trashcan and personal trashcans, your trashcan appears on your My DocuShare page. When you delete an object, it goes to your personal trashcan. You can restore and expunge an object from your personal trashcan if your Administrator has not expunged the object from the site-wide trashcan. See Using personal home page for more information.

If your site uses the site-wide trashcan only, then objects you delete go to it. To restore an object from the site-wide trashcan, you need to contact your Administrator. If trashcans are not used on your site, deleted objects are expunged immediately.

To delete an object:

1. Locate the object that you want to delete.
2. Do one of the following:
   - Click the checkbox that appears next to the object’s title. From the Edit Selected menu, select Delete.
   - From the object’s More Actions menu, select Delete.
   The Confirm Delete page appears.

   **Note:** If a minus sign appears in the checkbox that precedes the object, then you do not have manage permission to the object and cannot delete it.

3. If you are deleting a collection, select one of the following from the For collections, delete menu:
   - Collection and Contents to delete the collection and all the objects in it.
   - Collection Only to delete the collection, but not its contents.

   **Note:** If you delete a collection, but not its contents, and the objects are not located in another collection, they become orphaned. You are unable to access orphaned objects from a collection. Your Administrator can relocate orphaned objects in a collection so you can access them again.

4. Click Delete to remove the object from your site.
5. Working with documents

About documents

Using DocuShare, you can store, access, and manage documents created in a variety of popular formats. You add documents to DocuShare by uploading documents from your computer or a network drive or by scanning paper documents. With the documents stored on DocuShare, users connected to the network can use their browser to search for, view, edit, and download a document.

For document management, DocuShare supports version control and document locking. By default, DocuShare saves four versions of a document; you can change the number of versions DocuShare saves on a per-document basis. In addition, you can change a document’s preferred version, which is the version that opens when users view, edit, and route the document. By default, a document’s preferred version is its latest version.

Adding a document

You add a document to a collection or workspace to make it available to others for viewing or collaborative work. There are several ways to add documents.

Adding documents using the Add menu

Using the Add menu, you can upload a document and make it available immediately, or you can create a placeholder for a document and add it later.

To add a document using the Add menu:

1. Navigate to and open the container to which you want to add the document.
2. From the Add menu, select Document.
   The Add Document page appears.
3. In the Add Document By field, select one of the following:
   - Uploading a document now to upload a document immediately.
   - Scanning a document using a cover sheet to scan a paper document. This option appears if scanning is set up on your site. This causes a placeholder document to be added. The placeholder does not contain any content; you add content to the placeholder by scanning a document using a cover sheet.
   - Uploading a document later to upload a document later. This causes a placeholder document to be added. The placeholder does not contain any content; you add content to the placeholder by uploading a new version.
4. If you are uploading a document now, click the Choose File button to navigate to the document and select it.

5. Enter the following information:
   - Title—The title of the document. The title can contain spaces and punctuation marks.
   - Max Versions—The maximum number of versions to save. Once the maximum number of versions is reached, when a new version of a document is saved to DocuShare, the oldest version is deleted, unless it is the preferred version.

6. Enter any optional information. Click a field name for a description of each property.

7. Click Apply.

   If you are uploading a document, it is added to the container. If you are scanning a document, a cover sheet appears. Print the cover sheet. For information on how to use the cover sheet, see Scanning a document with a scan cover sheet. If you are uploading a document later, you can add the document content by adding a new version. See Uploading a new version of a document.

   If you chose to route the document, a Routing Slip appears. For information on how to use the Routing Slip, see Managing access to objects.

Adding documents using drag and drop

You can also add documents by dragging and dropping them into a collection. There are two options available when using this method: upload instantly or fill in properties and then upload.

To add a document using drag and drop:
1. Navigate to and open the collection to which you want to add the document.
2. Using your file manager, locate the document you want to add to DocuShare.
3. Click the document in your file manager and drag it to the collection.
4. Do one of the following:
   - If you would like to add the documents quickly and enter the file information later, drop the document onto the rectangle labeled Drop files here to instantly upload them as Documents. The document is uploaded. The filename appears as the title of the document.
   - If you would like to add the document and add properties such as Title, Author, and the Max Versions, drop the document onto the rectangle labeled Drop files here to select a type and fill details before uploading.

   Note: With either method, you can add several files at once. Use the Ctrl key and drag and drop the group of files to either rectangle.

Adding documents using Document Upload Page

Document Upload Page is a URL based generic document upload page. The user enters all the prompted properties and either select the document to upload from browsing the file system or drag and drop the document on the browser window. It is expected that the URL sent is encoded and the page decodes the values before using them.

The URL of Document Upload Page is of the following format:
Upload page Arguments

The URL specifies:

**Destination collection handle**

DestinationCollection=<<Collection Handle>>

<<Collection Handle>> is the collection handle or destination collection into which the document is uploaded. Collection handles are Case Sensitive, so please enter them in the format displayed below. It can be custom collection handle too. This is a required parameter.

Ex: - DestinationCollection=Collection-10 or DestinationCollection=Collection-11234

**Document Class Object:**

DSDocumentClassname=<<Object Class Name>>

<<Object Class Name>> is the object class name or object type the selected document is uploaded as. Object class names are Case Sensitive. It is important to enter them in the exact format as they were created in the format displayed below. If it is not specified, the default value used is the standard Document class.

Ex: - DSDocumentClassname =Document or DSDocumentClassname =AP_Invoice.

**Pre-Filled in Properties for the Document:**

{PreFilled Property1}=<<Value1>>

{PreFilled Property1} is the property name of the document object property which the user would like prefilled. These document properties are specified in curly brackets {}.

<<Value1>> is the user entered value which displays as pre-filled on the form when the page gets loaded. Object property names are case sensitive so please enter them in the exact format as they were created.

Ex: - {ClientName}=Verizon Wireless or {ClientNo}=VZ344342

**Properties to Query for:**

DSQUERY_FOR=Prop Name 1:Prop Label 1, Prop Name 2:Prop Label 2, Prop Name 3, Prop Name 4, Prop Name 5: Prop Label 5

DSQUERY_FOR is a list with either document property label and property value pairs or just property names or both, that the user is prompted to enter while uploading the document into DocuShare. The label to be displayed on the form can be specified as comma separated property name with the label on the form like Prop Name1:Prop Label1. If labels to be displayed are not given in the URL, it is retrieved from the DocuShare APIs and the same property label is displayed on the form. The same property label is displayed on the form. Different properties on the form are comma separated. Object property names are case sensitive, so it is important to ensure they are entered in the exact format as they were created.
Ex: - DSQUERY_FOR=ClientID:Client ID,InvoiceAmount:Invoice Amount,InvoiceDate:Invoice Date,InvoiceStatus:Invoice Status,BatchNumber:Batch Number,CheckAmount:Check Amount

**Collection Class Object:**

DSCollectionClassName=<<Object Class Name>>

<<Object Class Name>> specifies the collection class name to create collection path if the collection path is given to where the selected document is uploaded. If the path is specified and this parameter is not specified, then standard Collection class is the default object used while creating the collection path. Object class names are Case Sensitive, so it is important to ensure they are entered in the exact format as they were created in the format displayed below.

Ex: - DSCollectionClassName =Collection or DSCollectionClassName =Custom_Collection.

**Pre-Filled in Properties for Collection:**

(PreFilled Property1)=<<Value1>>

(PreFilled Property1) is the property name of the property on the collection object in round ‘(‘) brackets. <<Value1>> is its value to be used while creating the collection. Object property names are case sensitive, so it is important to ensure that they are entered in the exact format as they were created.

Ex: - (ClientName)=Verizon Wireless or (ClientNo)=VZ344342

**Collection Path to create under DestinationCollection:**

CollectionPathUnderDestinationCollection=Collection Title1/Collection Title 2/Collection Title 3

CollectionPathUnderDestinationCollection specifies the specific Collection Path under which the document should be placed under the Destination collection. The list of subcollection titles are separated by a forward slash / which is created under the Destination collection in that hierarchy. For example: ‘Collection Title 1’ is the title of Collection that is created under the DestinationCollection and ‘Collection Title 2’ gets created under ‘Collection Title 1’ and ‘Collection Title 3’ gets created under ‘Collection Title 2’. The Document is then uploaded under ‘Collection Title 3’.

**Optional Properties**

The optional properties that should be set while creating the collection. These collection properties are specified in round brackets ().
**URL Examples**

Example 1:
http://<<HOSTNAME>>:8080/docushare/jsp/DocumentUploader/add_document.jsp?DestinationCollection=Collection-10&DSClassname=Document&{VendorName}=ABCCorp&{InvoiceNumber}=12345678&DSQUERY_FOR=ClientID:ClientID,InvoiceAmount:InvoiceAmount,InvoiceDate:InvoiceDate,InvoiceStatus:InvoiceStatus,BatchNumber:BatchNumber,CheckAmount:CheckAmount

In this example, Document Upload Page is displayed in the Upload Documents window with vendorName with value ABCCorp, and InvoiceNumber with value 12345678. Any remaining properties in the window stay empty.

Example 2:

In this example, Document Upload Page is displayed in the Upload Documents window with property label ClientName with value Verizon Wireless, and ClientNo with value VZ344342. The remaining properties in the window stay empty.

**Identifying properties on the object**

Go to **Administration Menu | Object Properties** page and select the document object to use:

Select the Edit button next to the property of interest on the document object to display the Edit Property page to find the name of the property. Note that the Property label may be different than the Property name.

**Note:** Properties with no associated Edit button are global properties. Global properties can be found under **Administration Menu | Global Properties** page.

**Document upload process:**

For Example 1 above, the user opens a browser and launch the upload page with the desired set of parameters. The user enters all the prompted properties, selects the browse button, and selects the document from the file system to upload. The name of the file chosen appears next to the Browse Window.

Selecting the upload Document button uploads the document into the specified Collection and sets all the entered properties on the document and set the title to ABCCorp-Invoice.

**Drag and Drop Feature**

While adding the document, the document can be dragged and dropped onto the browser window.

The remaining controls includes a browse button next to a Pick Document label, a label for Document Title and an Upload Document button.

**Document Properties**

The document properties page displays all the properties that were entered on the upload page as well as the filename chosen.
Viewing a document

To view a document, you either open the document directly in the browser or first download it and then open it. Downloading the document copies it and keeps the original document on DocuShare.

Your browser controls how a document is displayed. By design, browsers can handle several types of documents and files, such as HTML, GIF, and JPEG. However, different browsers behave differently. For some documents, such as Microsoft Word and Excel, your browser may launch a helper application (viewer) to run or display the document either outside or within the browser window. To play some multimedia files, the browser uses a plug-in, which opens the file within the browser window.

Your browser is preconfigured to use specific helper applications and plug-ins. Generally, if you try to open a document or file that your browser does not recognize, it displays a window that guides you in finding the application to use for that type of file.

To view a document:
1. Locate the document that you want to view.
2. Click the document’s title. At this point, depending on your browser:
   - The document opens.
   - A window displays allowing you to view the document.
   - A window displays allowing you to download the document. Once it has downloaded, you need to open it.
3. To return to the container page after opening the document, do one of the following:
   - If the document opened in a separate window, select Exit from the File menu.
   - If the document opened within the browser window, click the browser’s Back button.

**Note:** If you click the X in the top-right corner of the browser or select Close from the File menu, your browser closes, and you lose your connection to the DocuShare site.

Viewing a document and its properties

In the document viewer, you can view both a document and its properties. You also can annotate and redact the document’s content, and edit the document’s properties.

To view a document and its properties:
1. Locate the document that you want to view.
2. Click the View Document & Properties icon that appears to the right of the document’s title.
   - Both the document and its properties display in a separate document viewer window.
3. Change any of the properties and click Update.
4. To annotate and redact the document, see Annotate and redact documents.
5. Click Close to close the window.
Viewing an HTML rendition of a document

DocuShare provides an HTML conversion feature that lets you view supported document types in HTML format. This feature eliminates the need to configure your browser to display certain document types.

**Note:** The HTML conversion feature cannot convert documents that contain encrypted information.

To view an HTML rendition of a document:
1. Locate the document that you want to view.
2. From the document’s More Actions menu, select View in HTML.
   DocuShare converts the document to HTML and displays the document.
3. Click the browser’s Back button to return to the container page.

**Viewing a PDF rendition of a document**

DocuShare provides a PDF conversion feature that lets you view supported document types in PDF format. This feature eliminates the need to configure your browser to display certain document types.

**Note:** The PDF conversion feature cannot convert documents that contain encrypted information. You must have Adobe® Reader® installed on your computer.

To view a PDF rendition of a document:
1. Locate the document that you want to view.
2. From the document’s More Actions menu, select View in PDF.
   DocuShare converts the document to PDF and displays the document.

**Adding a new document version**

There are two ways to add a new document version:
- Check out and edit an existing document, and check in the revised document as a new version.
- Upload a document as a new version of an existing document.

**Editing a document**

DocuShare supports the complete development cycle of a document, allowing users to collaborate on a project. Document check out and locking ensures that only one user at a time edits a document. Version control maintains a user-specified number of document versions.

To edit a document and create a new version, you must be either the logged-in owner of the document or a logged-in user with the appropriate permission to it. In addition, the DocuShare Administrator must have set the Add Versions property to Allowed.

**Note:** If a DocuShare desktop client is installed on your computer and you enabled the Handle checkout from web browser (or Internet Explorer) property, the DocuShare Checkin Wizard displays
after you edit and save the document. When using this feature, make sure DocuShare’s URL in the browser is the same as the server’s address in the DocuShare desktop client. To check the server’s address, right-click the server name and select Properties.

To edit a document:
1. Locate the document that you want to edit.
2. Click the document’s Check Out icon.
   A window appears allowing you to open or download the document.
3. Edit the document.
4. Do one of the following:
   – If the document opened in the browser, click the Back button. Click Yes to save your edits.
   – If the document opened in its native editor, select Save As from the File menu.
5. In the Save As window, save the document to a location on your local drive.
   Do not change the name of the document.
6. On the container page, click the document’s Upload a New Version icon.
   The Add Version page appears.
7. Click the Browse button.
8. Navigate to the location on your local drive in which you saved the edited document, select it, and click Open.
   The path to the document appears in the Filename field.
9. In the Title field, you can change the version title. By default, the new version is assigned the original document title.
10. Optionally, enter any comments in the Version Comments field.
11. If you locked the document, choose whether you want to unlock the document after adding the new version in the Unlock Document field.
12. When a document version other than the latest is the preferred version, you can click Yes in the Make This The Preferred Version field to set this version as the preferred one. Otherwise, click No to not change the preferred version.
13. Click Apply.

**Uploading a new version of a document**

You can add a new version of a document by uploading a document from a folder on your local drive or a network drive.

To add a new version of a document:
1. Locate the document that you want to update with a new version.
2. From the document’s More Actions menu, select Upload a New Version.
   The Add Version page appears.
3. Click the **Choose File** button.

4. Navigate to the location that contains the document you want to add as a new version, select it, and click **Open**.

5. In the **Title** field, you can change the document title. By default, the new version is assigned the original document title.

6. Optionally, enter any comments in the **Version Comments** field.

7. If the previous version of the document was locked, the **Unlock Document** field appears. Click **No** if you do not want to unlock the document after adding the new version.

8. Click **Apply**.

**Managing document versions**

DocuShare’s version control feature enables you to maintain a record of a document’s history. For each version DocuShare saves, you can view the content, the date and time the version was added, the user who added the version, and any user-provided comment. You can also view and edit each version’s properties and permissions, and route individual versions.

By default, DocuShare saves four versions of a document. You can change the default setting by changing the document’s **Max Versions** property.

**Viewing document versions**

To view a document’s version history:

1. Locate the document whose version history you want to view.

2. Click the document’s **Properties** icon.

   The View Properties page appears.

3. Click the **Version History** link.

   The page displays all saved versions of the document.

4. To view a specific version of the document, click its type or version number.

5. To return to the Version History page, do one of the following:
   - If the document opened in a separate window, select **Exit** from the **File** menu.
   - If the document opened within the browser window, click the browser’s **Back** button.

**Changing the preferred version**

By default, a document’s preferred version is the latest version. When there is more than one version of a document, you can change the document’s preferred version. This is the version of the document that opens when users view, edit, and route the document. However, users can route a specific document version from the document’s Version History page.

DocuShare always saves the preferred version, regardless of the number of **Max Versions** specified.
To change a document’s preferred version:

1. Display a document’s Version History page.
2. Click the **Change Preferred Version** button.
   
   Radio buttons display next to each version and the **Use Latest Version** option appears.
3. Do one of the following:
   
   - To select one of the existing versions as the preferred version, click the radio button next to the version you want.
   - To always have the latest version of the document be the preferred version, click the radio button next to **Use Latest Version**.
4. Click **Apply**.

**Viewing the renditions of a version**

Each version of a document can consist of several renditions. A rendition is the version’s display format, such as Microsoft Word, Adobe PDF, or HTML, and can be comprised of content files. For example, an HTML rendition of a document version would consist of the HTML file and several image files if the rendition contained graphics.

To view a version’s renditions:

1. Display a document’s Version History page.
2. To view the version renditions, click **Show Renditions**.
   
   The version renditions display and, if a rendition contains content files, those files display.
3. You can click a rendition or a content file to view it.
4. Click **Hide Renditions** to close the renditions view.

**Viewing and changing version properties**

To view and change a version’s properties:

1. Display a document’s Version History page.
2. Click the document version’s **Properties** icon.
   
   The View Properties page appears.
3. Click the **Edit** link.
4. Change the properties you want. Click a field name for a description of each property.
5. Click **Apply**.
Locking and unlocking a document

You can lock a document when you want to keep other users from editing it. To allow users to edit a locked document, you need to unlock the document. To unlock a document, you must be the logged-in user who locked the document. A document is locked if a Lock icon appears next to the document icon.

To lock a document:
1. Locate the document that you want to lock.
2. From the document’s More Actions menu, select Lock.
   
   A Lock icon appears next to the document icon. Users can view the document, but they cannot edit it.

To unlock a locked document:
1. Locate the document that you want to unlock.
2. From the document’s More Actions menu, select Unlock.
   
   A Lock icon no longer appears next to the document icon. Users can now edit the document.

Annotate and redact documents

Opening a document in the document viewer lets you search for content and annotate and redact content. To open the document viewer, click Open in Document Viewer from the document’s More Actions menu or click the View Document & Properties icon that appears to the right of the document’s title.

Note: Display Document Viewer should be enabled in the Site Configuration page so that View Document & Properties icon displays the Document Viewer page instead of the Side-by-Side viewer page.

Search for content to annotate and redact

Using search, you can find words and phrases in a document that you can then annotate and redact. The Search tab displays a search box and search operators like match whole word, match case, and proximity search.

To run a search:
1. Click the Search tab.
2. Enter the text you want to search for in the Search Document box.
3. Optionally, click one of the following:
   - Match Exact Word of Phrase—Find content with the exact word or phrase.
   - Match Case—Find content that matches the letter case you entered.
   - Whole Word—Find content that includes the search text.
   - Begins With—Find content that begins with the search text.
– **Ends With**—Find content that ends with the search text.
– **Use Wildcards**—Use the asterisk to match several characters. Use the question mark to match one character.
– **Proximity Search**—Enter two search terms, a tilde, and the number to indicate the distance between the two terms. For example, company invoice ~3.

4. Click the **Search** icon or press **Enter**.
5. The results display in the left sidebar. Click the result you want, and the page displays in the right pane of the viewer.
6. To clear the search results, click the X in the Search Document box.

**Annotate content**

The annotation feature allows you to collaborate and provide comments on documents. You can markup documents using three different types of annotations: drawing, text, and image.

The annotations you add are placed on a layer. If another user annotates the same document, that user's annotations are placed on a different layer. This lets you review all the annotations and merge the ones you want.

**Add annotations**

The Annotate tab provides the various annotation types that you can use. Using these tools, you can add a variety of shapes, highlight text, create links to websites, add images, and more.

To add annotations:

1. Click the **Annotate** tab.
2. On the toolbar, choose from the following annotation types:
   - **Arrow**—Draw an arrow.
   - **Line**—Draw a line.
   - **Rectangle**—Draw a rectangle.
   - **Ellipse**—Draw an ellipse.
   - **Freehand**—Draw a freehand line.
   - **Polyline**—Draw a line consisting of one or more line segments.
   - **Text**—Add text.
   - **Highlight**—Highlight text.
   - **Strikethrough**—Strikethrough text.
   - **Text Hyperlink**—Add a hyperlink. Follow the steps in **Add text hyperlink annotations**.
   - **Stamp**—Add a stamp.
   - **Image Stamp**—Add an image stamp.

The Annotation Options window displays in the upper-right corner of the viewer.
3. Select the options you want and then create the annotation. When creating a polyline annotation, double-click to stop drawing the annotation.

4. From the context menu that displays next to the annotation, you can add a comment, select the annotation, or cancel adding the annotation. You can also select the annotation and move it.

5. To delete an annotation, select it and click the Trash icon in the Annotation Options window.

6. To save the annotation, click the Save Annotations icon in the upper-right corner of the viewer. Your annotations are saved with your username on one layer.

Add text hyperlink annotations

1. On the toolbar, select Text Hyperlink.

2. Select the text that you want to add the hyperlink to. The Link text box appears.

3. Type the web address into the Link text box and click the checkmark (Done).

4. Click the text with the Hyperlink annotation to display the hyperlink. Note that “http://” is automatically added to the link.

5. Click the Pen icon to edit the hyperlink.

6. In the Annotation Options window, you can change the link, add a comment, select the checkbox to burn the hyperlink into the document, or delete the hyperlink. You can also select a different color for the hyperlink.

7. When finished, click the hyperlink to go to the website.

Redact content

If you work with sensitive content, the document viewer provides redaction features. More than simply hiding content visually, once the redactions are “burned in” the content is securely removed from the resulting document.

The Redact tab provides three different ways to redact content. You can draw redactions of any size you need, create redactions from selected text, or add redactions to an entire page or range of pages.

The redactions you make are placed on a layer. If another user redacts the same document, that user’s redactions are placed on a different layer. This lets you review all the redactions and merge the ones you want.

Redact search results

1. Run a search in the document viewer. See Search for content to annotate and redact.

2. At the top of the search results sidebar, click the Quick Actions icon (lightning bolt).

3. Click Redact All to redact occurrences of the search text.

4. Click Done.

Redact full pages

1. Click the Redact tab.

2. Click the Redact Full Pages icon.

3. In the Redact Full Pages window, select either All pages, Current page, or Page range.
4. Click **Redact**.

**Redact selected text**

1. Click the **Redact** tab.
2. Do one of the following:
   - Click the **Text Selection Redaction** icon.
   - Click the **Filled Rectangle** icon.
3. Highlight the text you want to redact.
4. From the context menu that displays next to the redaction, you can add a comment, select the redaction, or cancel the redaction. You can also select the redaction and move it.
5. When you are finished redacting content, click the **Save Annotations** icon in the upper-right corner of the viewer.

**Merge annotations and redactions**

You view and merge annotations and redactions in the Annotation Layers sidebar.

To view and merge annotations:

1. Click the **Annotation Layers** icon on the toolbar.
2. Under **My Annotations**, click the **Eye** icon to hide and display your annotations or redactions.
3. Next to **Annotations for Review**, click the **Options** icon and then select **Load Annotations**. The names of users who added annotations or redactions display.
4. Do one of the following:
   - Select the checkbox next to the user whose annotations or redactions you want to view, and then click **Done**.
   - Select the checkbox next to **Toggle All** and then click **Done**. The annotations or redactions display. You can hide and display each user’s annotations or redactions by clicking the **Eye** icon.
5. To merge annotations or redactions, do one of the following:
   - To merge the annotations or redactions from all users, click the **Options** icon and then select **Merge All Annotations**.
   - To selectively merge annotations or redactions, click the **Options** icon and then select **Merge Annotations**. Select the checkbox next to the user whose annotations or redactions you want to merge, and then click **Merge Selected to My Annotations**. All the annotations or redactions are merged to your layer.
Burn in annotations and redacted content

When you are ready to permanently add the annotations or remove the redacted content from a document, you “burn in” the changes. This created a PDF version of the document, which you can access from the document’s Versions page.

**Note:** The document is saved as a new version of the document. However, the preferred version is not changed.

To burn in annotations or redacted content:

1. If needed, view and merge the annotations or redactions. See Merge annotations and redactions.
2. In the upper-right corner of the viewer, click the **Burn-in** icon. Burn-in as fields display in the left sidebar.
3. Click the **Redactions** checkbox.
4. Click the **Burn-in** button.
5. In the Complete window, click the **Save** button.

Exporting documents

Your Administrator can set up locations on external servers to which you can export documents. You can export a single document or several documents at a time.

**Note:** This is only a CPX feature. A non-CPX user that has Admin privileges will not see the feature.

**Note:** When a site has 0 CPX license seats, the feature is still visible, and can be configured. But since there are no CPX users, the feature is not seen in the Edit Selected menu and cannot be used.

To export a document:

1. Locate the document that you want to export.
2. Click the checkbox that appears next to the document’s title.
3. From the **Edit Selected** menu, select **Export Document**. The Confirm Export Document page appears.
4. In the **Location** field, select the external location for the document.
5. Click the **Confirm** button.

Adding comments to a document

You can post comments to a document to maintain an informal commentary on it. For instance, when co-authoring a document, you can add helpful comments for the other document authors.

To post a comment on a document:

1. Locate the document on which you want to post a comment.
2. From the document’s **More Actions** menu, select **Comments**.
3. If there are current comments on the document, click the **Add a comment** link.
   The Add Comments page appears.
4. In the **Title** field, enter a name for the comment.
5. In the **Description** field, enter the comment text.
6. Click **Apply**.
   You can view the comments on a document by clicking its **Comments** icon. To edit a comment, click the comment’s **Edit** icon.

**Scanning documents**

You can add documents to your DocuShare site by scanning them. DocuShare provides two methods for scanning documents:

- You can use a scan cover sheet to scan documents to specific locations and as new document versions. At a multifunction device, you scan a cover sheet with a document to convert it to PDF format and add the digital document to DocuShare as specified in the cover sheet.

  **Note:** The scan cover sheet feature has been optimized for use with Xerox® Multifunction Devices. Therefore, the feature does not support all non-Xerox multifunction devices and software. In addition, DocuShare currently supports image-only file formats when scanning (TIFF, non-searchable PDF, etc.). Searchable PDF file formats are not supported for use with scan cover sheets.

- You can scan documents to a temporary scan collection that your Administrator sets up on your site. Using a WorkCentre with the Scan to File feature, you scan a document to convert it to TIFF format and add the digital document to the temporary scan collection. You then save the scanned document to a permanent collection on your site.

Your Administrator determines which method you can use for scanning documents. Therefore, check with your Administrator to find out how your site is set up.

**Scanning documents using scan cover sheets**

You can scan documents to specific locations and as new document versions using scan cover sheets. You can create scan cover sheets for these types of objects:

- documents—to scan a document as a new document version
- collections—to scan a document to a collection
- workspaces—to scan a document to the content portlet of a workspace
- user—to scan a document to your personal collection

A scan cover sheet includes a **DataGlyph**, which encodes machine-readable information about the scan location and the cover sheet owner. You place the cover sheet on top of a document and scan both to add the resulting PDF document to DocuShare.
In addition, you can choose to create a cover sheet for a document when using the Add Document page to upload a document. For more information, see Adding a document.

Creating a scan cover sheet

To create a scan cover sheet:

1. Do one of the following:
   - To create a cover sheet for a document, collection, or workspace, locate the object. Then click the object’s Properties icon.
   - To create a cover sheet for your personal collection, click your username on the navigation bar.

2. On the View Properties page, click the Scan Cover Sheet link.

3. Click the Create Scan Cover Sheet link.
   The cover sheet is created and opens in a separate window.

4. Print the cover sheet. Then close it.
   The Scan Cover Sheet page lists the cover sheet and provides the date and time at which it was created.

Scanning a document with a scan cover sheet

If you have access to a multifunction device that supports Scan to File, you can scan a cover sheet with a document to add a PDF version of the document to DocuShare.

Note: Since the user interface for multifunction devices can vary, the following procedure provides general steps for scanning a document to DocuShare.

To scan a document:

1. Put the cover sheet on top of a document and place the pages in the document feeder.
2. Display the scan to file screen.
3. Follow any instructions specific to the type of device.
4. Press the Start button.
   The device scans the document and then adds it to DocuShare as specified in the cover sheet.

Deleting a scan cover sheet

When you no longer want a cover sheet to be used to scan a document, you can delete it. Deleting the cover sheet invalidates any printed copies of it. You might want to delete a cover sheet if you misplace it and do not want anyone else to use the cover sheet.

To delete a scan cover sheet:

1. Locate the object whose cover sheet you want to delete.
2. Click the object’s Properties icon.
3. On the View Properties page, click the Scan Cover Sheet link.
4. Click the Trashcan icon that appears to the right of the cover sheet.

**Scanning documents to a temporary scan collection**

If you have access to a WorkCentre with the Scan to File feature enabled, you can scan documents to DocuShare. Your WorkCentre Administrator must set up a scan template before you can scan documents to DocuShare. When setting up a scan template, the Administrator can choose to save each document page to a TIFF file or to save all the document pages to a single TIFF file. Also, you may be able to use a scan template to enter DocuShare property values at the device, before scanning the document. After the document is scanned to a collection, the values you entered appear on the View Properties page for the document.

Before you begin, check with your Administrator to find out which templates are available for your use and whether a password is required.

*Note:* Depending on which WorkCentre model you use, the steps for scanning a document can vary. DocuShare does not support scanning color images on a WorkCentre Pro 40 using JPEG compression (JPEG-in-TIFF).

To scan a document:

1. Place a document on the document glass or in the document feeder.
2. Press the **Features** button.
3. On the touch screen, press the **Scan** tab.
4. Press **Scan to File**.
5. Select the scan template.
6. If the template requires a password, do the following:
   a. Press **Added Features**.
   b. Press **Filing Setups**.
   c. Press **Login Name/Password**.
   d. Press **Password**.
   e. Type your password and press **Save**.
   f. Press **Save**.
7. If the template allows you to specify property values, enter values for the ones you want.
8. Press the **Start** button.

The WorkCentre scans the document and then sends it to the temporary scan collection on your DocuShare site. The document is stored in this collection for a designated time period. You can check the time period by clicking **WorkCentre Scan Repository** on the DocuShare home page. To keep the document, you need to save it to a permanent collection.

**Saving a scanned document to a collection**

To save a scanned document to a collection:

1. Go to the DocuShare home page.
2. Click **WorkCentre Scan Repository**.

3. If the **Passcode** field appears, enter the password you entered at the WorkCentre to scan the document and then click **Enter Passcode**.

4. Locate your scanned document.

5. Click **Save**.
   
   If you do not want to save the document to a collection, click **Delete** to remove the document from the temporary scan repository.

6. If you want to rotate the document, select the number of degrees from the **Rotate Image** menu and click **Go**.

7. From the **Document Type** menu, select the type of document to save the scanned document as.
   
   The menu contains types in addition to **Document** if your Administrator created custom documents on your site.

8. If your Administrator specified a default collection in which to save scanned documents, its title appears in the **Destination** field. Do one of the following:
   
   - If you want to use the default collection, go to step 13.
   - If you want to change the collection, click **Select**. The Select Destination page appears.

9. In the **Sort By** field, select **Title** to display the collections in alphabetical order or select **Handle** to display the collections in numerical order.

10. Do one of the following:
    
    - To find specific collections, enter any part of a collection title in the **Search** field. Click the **Go** button.
    - To list all collections, click **Show All** (if displayed).
    - To display your favorite collections, click **Show Favorites**.
    - To display your personal collection, click **Show Personal Collection**.

11. In the **Possible Locations** field, select the collection to which you want to save the document.

12. Click **Apply**.

13. In the **Title** field, enter a title for the document.

14. Enter any additional information. Click a field name for a description of each property.

15. Click **Save**.
   
   The document is saved to the collection you specified.

**Note:** Your Administrator may have given you access to a collection named **Temporary Scan Repository**. Alternatively, you can open this collection to move or delete your scanned document.
6. Setting up notifications

About notifications

A notification allows you to receive an email message when a change occurs to an object. You can add a notification for any object on your site. For example, you can add a notification for a document to have DocuShare email you when a new version of the document is uploaded. You might want to add a notification for a collection to know when new content is added to the collection.

To use notifications, your Administrator must enable and set up the feature. In addition, your user account properties must include an email address.

You can add a notification for any of the following changes to an object:

- **Any change**—Any change to the object.
- **Something added**—A new object is added to a container.
- **New document version added**—A new version of a document is added.
- **Something deleted**—An object is deleted from a container.
- **Properties edited**—The properties of the object are changed.
- **Permissions edited**—The permissions of the object are changed.
- **Change in ownership**—The owner of the object is changed.
- **Location edited**—The location of the object is changed.
- **Document locked or checked out**—The document is locked or checked out.
- **Document unlocked**—The document is unlocked after being locked, but a new version of it was not added.

*Note:* DocuShare offers feeds to site collections and other types of containers. If you are using a browser with built-in feed support or you have a feed reader installed on your computer, you can add a feed to a DocuShare container. This enables you to view updated content in the container, provided you have the necessary permissions, without having to go to the DocuShare site in your browser.

Adding a notification

You can quickly add a simple notification to have DocuShare email you when new content is added to an object, or you can choose advanced options to customize the notification.

To add a notification:
1. Locate the object for which you want to add a notification.
2. Do one of the following:
   - From the More Actions menu, click the object’s Notifications icon.
Click the object’s Properties icon. Then click the Notifications link.

3. On the Notifications page, click Create a New Notification.

4. In the Period field, select one of the following time periods:
   - Immediate provides notification immediately after the event occurs.
   - Daily provides notification in a daily summary report.
   - Weekly provides notification in a weekly summary report.

5. To select advanced options, click Show Advanced Options and choose from the following:
   - Events of Interest—The event or events of which you want to be notified. To select multiple events, use the Ctrl key (Windows) or the Command key (Macintosh).
   - Include Recipient Activity—Specifies whether to also notify the user whose action caused the notification. Select Yes to notify the user; otherwise, select No.
   - External Recipients—The email addresses for recipients who are not registered users on the DocuShare site. Separate email addresses with a comma. This field is optional.
   - Sender—The username that appears in the email message From field: Admin or Owner.
   - Notification Applies To—if the object is a collection or a workspace, specifies how to apply the notification to the collection and the objects in it.
   - Initial Permissions—Specifies the permissions for the notification.

   **Note:** If you are an Administrator, additional fields appear enabling you to have a script run when an event of interest occurs. Before entering information in the fields, you must create a script and place it in the extension folder of your DocuShare directory. In the Script field, enter the name of the script that you want to run when the event of interest occurs. In the Script Data field, enter any string values that you want to pass to the script when it is called.

6. Click Apply.

   **Note:** If you are receiving too many email messages from notifications, you can choose to not receive messages for one or more types of events for all your notifications. Click your username on the navigation bar and use the Suppress Notification Messages menu on the Edit page to turn off the events you want.

### Viewing notifications

You can easily view the notifications added for an object as well as the notifications you own for site objects.

To view an object’s notifications:

1. Locate the object whose notifications you want to view.
2. Do one of the following:
   - From the More Actions menu, click the object’s Notifications icon.
   - Click the object’s Properties icon. Then click the Notifications link.

   The object’s current notifications display.
To view your notifications:

1. On the navigation bar, click your username.
2. On the View Properties page, scroll to locate the **Subscribed To** property.
   The notifications you added for objects display in the field. You can click a notification to view its properties.

### Creating a recipient list for a notification

You can create a recipient list for a notification to have DocuShare notify others when a change occurs to an object. For example, you may want co-workers to know when a new version of a document is uploaded or when an object is moved to another location.

To create a recipient list for a notification:

1. Locate the object that has the notification for which you want to create a recipient list.
2. Do one of the following:
   - From the **More Actions** menu, click the object’s **Notifications** icon.
   - Click the object’s **Properties** icon. Then click the **Notifications** link.
   The object’s current notifications display.
3. Click the **Properties** icon that appears to the right of the notification you want to change.
   The View Properties page appears.
4. Click the **Recipients** link.
5. Click **Change Recipients**.
6. In the **Show** field, select the type of account you want to display in the **Possible Users/Groups** field.
7. Do one of the following:
   - To find a specific account, enter part of the user’s first name, last name, or username or the group’s title in the **Search** field. Click the **Go** button.
   - To list all accounts, click **Show All** (if displayed).
   - To display your favorite accounts, click **Show Favorites**.
8. In the **Possible Users/Groups** field, select the accounts to add to the recipient list and click the **Add** button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).
9. In the **Selected Users/Groups** field, select any accounts that you want to remove from the recipient list and click the **Remove** button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).
10. Click **Update**.
Viewing and changing notification properties

When you add a notification, a default name is assigned to it. You may want to change the name to something more descriptive as well as change other properties.

To view and change an object’s notification properties:

1. Locate the object whose notification properties you want to view and change.
2. Do one of the following:
   – From the More Actions menu, click the object’s Notifications icon.
   – Click the object’s Properties icon. Then click the Notifications link.

   The object’s current notifications display.
3. Click the Properties icon that appears to the right of the notification you want to change.

   The View Properties page appears.
4. Click the Edit link.
5. Change the properties you want. Click a field name for a description of each property.
6. Click Apply.

Deleting a notification

Depending on how your site is set up, a deleted notification can go to either your personal trashcan on My DocuShare or the site-wide trashcan. Contact your Administrator to find out which trashcans are used on your site. If you have a personal trashcan, you can restore an object from it if your Administrator has not expunged the object from the site-wide trashcan. See Using personal home page for more information.

To delete a notification:

1. Locate the object with the notification you want to delete.
2. Do one of the following:
   – From the More Actions menu, click the object’s Notifications icon.
   – Click the object’s Properties icon. Then click the Notifications link.

   The object’s current notifications display.
3. From the More Actions menu that appears to the right of the notification you want to delete, select Delete This Notification.

   The Confirm Delete page appears.
4. Click Delete.
Customizing notifications

You can customize the content and layout of the email notification message that is sent when a change occurs to an object. You do this by editing the subscription email templates. When you add notifications for site objects, you select the template to use.

To customize a notification email template:
1. Locate the object whose notifications you want to view.
2. Do one of the following:
   - From the More Actions menu, click the object’s Notifications icon.
   - Click the object’s Properties icon. Then click the Notifications link.
   The object’s current notifications display.
3. Click the notification you want to customize.
4. Click Edit Email Template.
5. Set Enable Email Template to Yes.
6. Set the Email Format: HTML or Plain Text.
7. From the Select an Email Template combo box, select the template you would like to customize.
8. Customize the file using the information below.
9. Once you are done customizing the template, click Apply to save your changes.

Customizing the subscription.tpl file

The DocuShare-provided subscription.tpl file consists of 11 sections; the section headings are enclosed within square brackets. Each section defines a part of the email message and is used for either plain text-formatted email messages, HTML-formatted email messages, or both.
subscription.tpl section headings

<table>
<thead>
<tr>
<th>Template File Section</th>
<th>Definition</th>
<th>Email Format of Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>[subscription.obj.props]</td>
<td>Object properties other than the default set of object properties.</td>
<td>Plain Text &amp; HTML</td>
</tr>
<tr>
<td>[subscription.parent.props]</td>
<td>Container properties other than the default set of container properties.</td>
<td>Plain Text &amp; HTML</td>
</tr>
<tr>
<td>[subscription.mail.subject]</td>
<td>The subject of a subscription message.</td>
<td>Plain Text &amp; HTML</td>
</tr>
<tr>
<td>[subscription.mail.header]</td>
<td>The header of a subscription message.</td>
<td>Plain Text</td>
</tr>
<tr>
<td>[subscription.mail.body]</td>
<td>The body of a subscription message.</td>
<td>Plain Text</td>
</tr>
<tr>
<td>[subscription.mail.footer]</td>
<td>The footer of a subscription message.</td>
<td>Plain Text</td>
</tr>
<tr>
<td>[subscription.misc]</td>
<td>A miscellaneous section of a subscription message that appears after the footer.</td>
<td>Plain Text &amp; HTML</td>
</tr>
<tr>
<td>[subscription.mail.header.html]</td>
<td>The header of a subscription message.</td>
<td>HTML</td>
</tr>
<tr>
<td>[subscription.mail.body.html]</td>
<td>The body of a subscription message.</td>
<td>HTML</td>
</tr>
<tr>
<td>[subscription.mail.footer.html]</td>
<td>The footer of a subscription message.</td>
<td>HTML</td>
</tr>
</tbody>
</table>

The lines following a section heading apply to that section. Each line can contain a comment, preceded with a pound character (#), or hard coded text, named parameters, and HTML tags without leading/trailing whitespace characters.

The format of each named parameter that you can include in the lines is as follows:
### Formats of parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{&lt;property_name&gt;}</code></td>
<td>Substitute <code>&lt;property_name&gt;</code> with object’s property value.</td>
</tr>
<tr>
<td><code>{parents.&lt;property_name&gt;}</code></td>
<td>Substitute <code>&lt;property_name&gt;</code> with property value of object’s parent container.</td>
</tr>
<tr>
<td><code>{label.&lt;property_name&gt;}</code></td>
<td>Substitute <code>&lt;property_name&gt;</code> with label of object property.</td>
</tr>
<tr>
<td><code>{label.parent.&lt;property_name&gt;}</code></td>
<td>Substitute <code>&lt;property_name&gt;</code> with label of parent container’s property.</td>
</tr>
<tr>
<td><code>{subscription.&lt;property_name&gt;}</code></td>
<td>Substitute <code>&lt;property_name&gt;</code> with subscription object’s property value.</td>
</tr>
<tr>
<td><code>{event.message.&lt;section_tag&gt;}</code></td>
<td>Substitute <code>&lt;section_tag&gt;</code> with subscription object’s property value.</td>
</tr>
<tr>
<td><code>{emitter.&lt;property_name&gt;}</code></td>
<td>Substitute <code>&lt;property_name&gt;</code> with emitter’s property value.</td>
</tr>
<tr>
<td><code>{owner.&lt;property_name&gt;}</code></td>
<td>Substitute <code>&lt;property_name&gt;</code> with property value of object’s owner.</td>
</tr>
<tr>
<td><code>{&lt;site_property_name&gt;}</code></td>
<td>Substitute <code>&lt;site_property_name&gt;</code> with site property value.</td>
</tr>
</tbody>
</table>

The Subscription Service provides a default set of object and parent container properties. For a property other than one of the default properties listed below, define it in either the `[subscription.obj.props]` or the `[subscription.parent.props]` section.

#### Object properties
- `classname`, `handle`, `handle_url`, `props_view_url`, `title`, `description`, `summary`, `keywords`, `create_date`, `modified_date`, `entry.title`

#### Parent container properties
- `parent.handle`, `parent.handle_url`, `parent.title`

#### Subscription properties
- `subscription.handle`, `subscription.handle_url`, `subscription.title`

#### Object owner and emitter properties
- `owner.handle_url`, `owner.username`, `emitter.username`

#### Site properties
- `icon`, `domain`, `sitename`, `server_url`, `event_time`

#### Object property labels
- `label.title`, `label.description`, `label.summary`, `label.keywords`, `label.create_date`, `label.modified_date`

#### Other property labels
- `label.parent.title`, `label.domain`, `label.emitter.username`, `label.link_type`
Event messages (uses messages from SubscriptionMessage.properties based on the event type)

**event.message.subject**—Substitutes with the messages prefixed with subject.text.<type>, where <type> is the event type.

**event.message.header**—Substitutes with the messages prefixed with intro.text.<type>, where <type> is the event type.

**event.message.header.html**—Substitutes with the messages prefixed with intro.text.<type>, where <type> is the event type. <p> tag precedes the message.

**event.message.footer**—Substitutes with the messages prefixed with footnote.text.<type>, where <type> is the event type.

**event.message.footer.html**—Substitutes with the messages prefixed with footnote.html.<type>, where <type> is the event type.

**Note:** {event.message.subject} can be changed to some hard-coded text. However, appending the value to {event.message.subject} is not supported. The site Administrator must enable **Update Email Template** in the administration page to load keys each time.

The following example displays a section of the template file:

```plaintext
[subscription.obj.props]
#object properties : eq. <property_name>,...
invoice_amount

[subscription.mail.header]
# Comment 1 for header section
Line 1 text for header section
Line 2 text for header section

[subscription.mail.body]
# Comment 2 for body

[subscription.mail.body.html]
#message body section in html form
<br><TABLE CELLPADDING=4><TR VALIGN="TOP">
<TD ALIGN="CENTER"><img src="{icon} ">
<br></TD>
<TD><A HREF="{handle_url} ">{title}
<font color='blue'><br>{label.invoice_amount} {invoice_amount}</font>
<br>{summary}
<br>{description}
<br><I>Appears In: </I> <A HREF="{parent.handle_url} ">{parent.title}
<br></TD>
<TD><A HREF="{owner.handle_url} ">{owner.username}</A>
```
<TD>{create_date}</TD><br>
<TD><A HREF="{parent.handle_url}" Props</TD></TR></TABLE><br>

[subscription.mail.footer]
# Comment 3 for footer section
Line 3 text for footer section
Line 4 text for footer section

**Note:** The [subscription.mail.body] section does not include any parameters.

The subscription.tpl file

This section provides a copy of the contents of the template file.

#---- extra properties of dsobject or parent container dsobject------------

-----

[subscription.obj.props]
#object properties : e.g. <property_name>,<property_name>,etc.

[subscription.parent.props]
#parent container properties : e.g. <property_name>,<property_name>,etc.

#---- in plain Text -----------------------------------------

[subscription.mail.subject]
#subject section
{event.message.subject}

[subscription.mail.header]
#header section in plain text form
{event.message.header}

[subscription.mail.body]
#message body section in plain text form
URL:{handle_url}
{label.title} : {title}
{label.summary} : {summary}
{label.description} : {description}
{label.abstract} : {abstract}
{label.summary} : {revision_comments}
{label.handle} : {handle}
{label.create_date} : {create_date}
Owner : {owner.username}
10. Once you are done customizing the template, click **Apply** to save your changes.
7. DocuShare workspaces

About workspaces

A workspace provides a shared area for project and team collaboration. From a single page within DocuShare you and other workspace members can gather and manage shared content, access collaboration tools to facilitate your work, and communicate with each other.

A workspace consists of four distinct areas called portlets; each portlet has a different use.

- **Content portlet**—The area in which you add and manage shared content.
- **Shortcuts portlet**—Displays frequently used objects.
- **Calendar portlet**—Shows a combination of the calendars in the content portlet.
- **Membership portlet**—Lists the users who are members of the workspace membership group.

You can close a portlet and reopen it by clicking the small triangle next to the portlet title.

Adding a workspace

You can add a workspace to another workspace, or you add a workspace to My DocuShare. To guide you in creating a workspace, DocuShare provides templates and a wizard.

When adding a workspace, a **membership group** is created automatically and initially includes you as its member. You can add members to the group after the workspace is added. The members are listed in the membership portlet on the workspace home page.

**Note:** If you are a Site Administrator or a Content Administrator, an [add] link appears on the home page. This allows you to add a workspace to your site home page.

To add a workspace:

1. To add a workspace to another workspace, do one of the following and then go to step 3:
   - On the DocuShare home page, click **See More** under Workspaces. Search for the workspace to which you want to add a workspace. Open the workspace and select **Workspace** from the **Add** menu.
   - Go to My DocuShare. In the workspaces portlet, search for the workspace to which you want to add a workspace. Open the workspace and select **Workspace** from the **Add** menu.
   - Navigate to and open the workspace to which you want to add a workspace. In the content portlet, select **Workspace** from the **Add** menu.

2. To add a workspace to My DocuShare, do one of the following:
   - On the DocuShare home page, click **See More** under Workspaces. Then click **Add a Workspace**.
– Go to My DocuShare. In the workspaces portlet, click **Add a Workspace**.

3. On the Add a New Workspace page, select one of the following templates:
   – **Document Storage**—includes four workspace collections in the content portlet.
   – **Team Project**—includes one workspace collection, a calendar, and a collection for online meeting URLs in the content portlet.

4. Click **Next**.

5. In the **Title** field, enter a name for the workspace.

6. Enter any optional information. Click a field name for a description of each property.

7. Click **Done**.

The workspace home page appears.

## Controlling access to the workspace

To change the users and groups that have access to the workspace, you simply change the members of the workspace membership group. Any user or group that you add to the group is assigned full read and write permissions to the workspace. You can choose to give the group manage permission to the workspace.

In addition to listing the group members, the membership portlet enables you to see which users are logged into DocuShare. The user icon next to the user’s name in the portlet indicates whether or not the user is logged in; the icon is grayed when the user is not logged in.

Like other DocuShare objects, a workspace has an access list, which you can use to give users and groups access to the workspace. However, any users and groups that you add to the access list are not listed in the membership portlet.

### Changing the users and groups in the membership group

If you are the workspace owner or a member of the membership group (and the group is assigned manage permission to the workspace), you change the users and groups in the group.

**Note:** The membership portlet lists users only. Therefore, individual group members are listed and not the group titles.

To change the members of the membership group:

1. On the workspace home page, do one of the following:
   – Click the **Membership** heading.
   – Click the **Properties** icon. On the Properties page, click the **Membership** link.

   The Membership page appears displaying the current members.

2. Click the **Change Membership** link.

3. In the **Show** field, select the type of account you want to display in the **Possible Users/Groups** field.

4. Do one of the following:
– To find a specific account, enter part of the user’s first name, last name, or username or the group’s title in the Search field. Click the Go button.
– To list all accounts, click Show All (if displayed).
– To display your favorite accounts, click Show Favorites.

5. In the Possible Users/Groups field, select the accounts to add to the group and click the Add button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

6. In the Selected Users/Groups field, select any accounts that you want to remove from the group and click the Remove button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

7. Click Update.

The Members page appears.

8. To give one or more members manage permission to the group, click the checkbox next to each member’s name and then click Apply. Manage permission allows the member to change the group’s properties and membership.

9. To assign manage permission to the membership group, display the Permissions page for the workspace. Click the Manage or Manager box for the group and click Apply.

Re-assigning the membership group

As needed, you can change the membership group that is associated with the workspace by assigning a different group to the workspace.

To re-assign the membership group:

1. On the workspace home page, click the Properties icon.
2. On the Properties page, click the Permissions link.
3. Click the Re-assign Membership Group button.

The Re-assign Membership Group page appears.

4. Do one of the following:
   – To find a specific group, enter part of the group’s title in the Search field. Click the Go button.
   – To list all groups, click Show All (if displayed).
   – To display your favorite groups, click Show Favorites.

5. In the New Membership Group field, select the group you want to associate with the workspace.

6. Click Save.

The previous membership group remains in the workspace’s access list.

Adding content to the workspace

You can add any type of object, including another workspace, to a workspace.
To add content to the workspace:
1. In the content portlet, select the type of object that you want to add from the Add menu.
2. On the Add page, enter the required information, and click Apply.
   The object appears in the content portlet.

To use workspace view features:
1. From the Show menu, select the type of object you want to display.
2. Click a View icon to switch between the icon and list views.

Managing shortcuts

To conveniently access frequently used objects from a workspace, you can add shortcuts to them. Any object you add as a shortcut is a link to the original object, not a copy. If the original object is deleted, it no longer appears as a shortcut.

To add a shortcut to a workspace:
1. Locate the object that you want to add as a shortcut.
2. Click the checkbox that appears next to the object’s title.
3. From the Edit Selected menu, select Copy Shortcuts.
4. On the Confirm Copy Shortcuts page, click Confirm.
5. Navigate to and open the workspace to which you want to add the shortcut.
6. In the shortcuts portlet, click the Paste Shortcuts icon.
7. On the Confirm Paste Shortcut page, click Confirm.
   The object you added appears in the shortcuts portlets. You can use the Show menu to display one type of object, such as documents. The View icons let you switch between the icon and list views.

To remove a shortcut from a workspace:
1. Navigate to and open the workspace that contains the shortcut that you want to remove.
2. In the shortcuts portlet, click the List View icon to display the shortcuts in a list.
3. Click the Remove Shortcut icon that appears next to the object you want to remove.
4. On the Confirm Remove Shortcut page, click Confirm.
   The object no longer appears in shortcuts. However, the object still appears in its original locations.

Using calendars

The calendars portlet displays all the calendars from the content portlet. This allows you and other workspace members to quickly access individual calendars as well as to view the events from all calendars.
To use the calendars portlet:

1. From the Show menu, select the calendar that you want to view or select All Calendars to view all calendars.

2. Using the View icons, you can switch between daily and weekly calendar views.

Changing portlet properties

Each portlet has default display properties that you can change. For example, you can set the default view to list view to display objects in a collection-style listing.

To change the properties of a portlet:

1. Click the portlet’s Edit button.

2. Depending on which portlet properties you are changing, do one or all the following:
   a. In the Page Size field, enter the number of objects to display on each page.
   b. In the Sort Order field, enter the order in which to display objects.
   c. In the View Type field, enter the type of view used to display objects.

   Click a field name for a description of each property.

3. Click Apply.
8. Using social computing features

About social computing features

DocuShare enables you and other users to discuss, share, and collaborate regardless of location using its social computing features:

- **Discussions**—A discussion is an online forum that allows users to interact by posting topics and replies to topics.
- **Weblogs**—A weblog allows a user to create and share a personal website on a particular subject. The weblog includes postings in reverse chronological order and allows others to comment on the postings.
- **Wikis**—A wiki enables a group of users to collaborate on a website by creating, editing, and linking web pages.

Adding a discussion

To facilitate an online exchange of ideas, DocuShare supports threaded discussions. You can add a container, called a discussion, in which users add topics for other users to read and reply to. As users reply to a topic, their responses are sequentially linked, or threaded, to the original topic. Users can read or reply to any of the topics or replies in a thread as well as attach a document to a topic or reply.

You can add a discussion to a collection or workspace.

To add a discussion:

1. Navigate to and open the container to which you want to add a discussion.
2. From the Add menu, select Discussion.
   
   The Add Discussion page appears.
3. In the Title field, enter a name for the discussion. The name should be short, but descriptive, and can contain spaces and punctuation marks.
4. In the Topics Expire In field, select the length of time to retain topics and their message threads in the discussion after they are added.

   When a topic becomes older than the duration you select, it no longer appears in the discussion. You can view and delete expired topics on the discussion’s View Expired page.
5. Enter any optional information. Click a field name for a description of each property.

   **Note:** If your Administrator created custom properties, they also display on the page. See your Administrator for information about custom properties.
6. Click **Apply**.
   The discussion is added to the container.

### Adding topics, attachments, and replies to a discussion

A topic is the first message added to a discussion and initiates the online conversation. Users can reply to the topic as well as to individual replies. By default, replies are indented, which provides a hierarchical display of the discussion.

To add a topic:

1. Open the discussion to which you want to add a topic.
2. Click the **Add Topic** button.
   
   **Note:** If your Administrator created a custom topic, it appears in the Add menu.
3. In the **Title** field, enter a name for the topic.
4. In the **Description** field, enter the body of the topic.
5. Click **Submit**.
   The topic is added to the discussion.
6. If you want to attach a document to the topic, do the following:
   a. Click the **Attach** button.
      The Add Document page appears.
   b. Enter the complete path and filename of the document in the **Filename** field or click the **Browse** button to navigate to and select the document.
   c. In the **Title** field, enter a document name.
   d. Click **Apply**.
      The document appears on the topic.

To add a reply:

1. Navigate to and open the discussion.
2. Locate the topic or reply to which you want to reply.
3. Click the **Reply** button.
4. Enter a title and description.
5. If you want to include the previous message and the name of the user who added it, click **Quote Post**.
6. Click **Submit**.
7. If you want to attach a document to the reply, do the following:
   a. Click the **Attach** button.
      The Add Document page appears.
   b. Enter the complete path and filename of the document in the **Filename** field or click the **Browse** button to navigate to and select the document.
c. In the **Title** field, enter a document name.

d. Click **Apply**.

   The document appears on the reply.

**Viewing and deleting expired topics**

If you set an expiration for the topics added to a discussion, you can view and delete the expired topics.

To view and delete expired topics:

1. Locate the discussion whose expired topics you want to view.

2. Click the **Properties** icon that appears to the right of the discussion’s title.

   The View Properties page appears.

3. Click the **View Expired** link.

   The page displays all the expired topics that no longer appear on the discussion.

4. Do one of the following:
   - Select the individual topics that you want to delete.
   - Click **Select All** to select all the topics.

5. Click **Delete Selected**.

**Adding a weblog**

A weblog is a simple web site on which you post entries about a specific topic on a regular basis. Entries are displayed in reverse chronological order and include the name of the user who posted the entry.

When adding a weblog, you can choose to have it moderated. A moderated weblog requires a user with manage permission to the weblog to approve its entries before they are posted for all users to read.

You can add a weblog to a collection or workspace. By default, when you add a weblog, you are the only user who can post entries to it (**Initial Permissions** is set to **Same as container except write restricted to owner**). If you want other users and groups to add entries to the weblog, either change the **Initial Permissions** setting when adding the object or change the object’s permissions after adding it.

To add a weblog:

1. Navigate to and open the container to which you want to add a weblog.

2. From the **Add** menu, select **Weblog**.

   The Add Weblog page appears.

3. In the **Title** field, enter a name for the weblog. The name should be short, but descriptive, and can contain spaces and punctuation marks.

4. Change any of the default property values and enter any optional information. Click a field name for a description of each property.
5. Click **Apply**.

The weblog is added to the container.

**Note:** When you create a weblog using a custom theme, that theme is used to display weblog pages. Any theme you select on your User Properties page has no effect on the weblog pages. When you create a weblog using a default or clean theme, the theme you select on your User Properties page is used to display weblog pages.

### Posting weblog entries

To add content to a weblog, you post entries to it. By default, entries appear in reverse-chronological order.

**To post an entry:**

1. Locate and open the weblog to which you want to post an entry.
2. Click the **Add Entry** link.

   The Add Weblog Entry page appears.
3. In the **Title** field, enter a name for the entry. The name should be short, but descriptive, and can contain spaces and punctuation marks.
4. In the **Description** field, enter the body of the entry.
5. Enter any optional information. Click a field name for a description of each property.

   **Note:** If your **Administrator** created custom properties, they also display on the page. See your **Administrator** for information about custom properties.
6. Click **Apply**.

   The entry appears in the weblog and includes the date the entry was posted and your username. If the weblog is moderated, **Approval Pending** precedes your username. Users cannot read the entry until a user with manage permission to the weblog approves it.

### Editing weblog entries

**To edit an entry:**

1. Locate and open the weblog that contains the entry you want to edit.
2. Click the **Edit** icon next to the entry.
3. Make the changes you want.
4. Click **Apply**.

### Deleting weblog entries

**To delete a weblog entry:**

1. Locate and open the weblog that contains the entry you want to delete.
2. Click the weblog entry title.

3. From the weblog entry’s More actions menu, select Delete.
   The Confirm Delete page appears.

4. Click Delete to remove the object from your site.

**Approving weblog entries**

If you are a user with manage permission to a weblog that is moderated, you must approve an entry before it is posted for all users to read.

To approve an entry:

1. Do one of the following:
   - Locate and open the weblog that contains the entry you need to approve. Click the check mark next to the entry.
   - On the navigation bar, click My Tasks. From the Show menu, select Tasks Assigned to Me. Click the weblog entry title.
   - On the navigation bar, click My DocuShare. The tasks assigned to you display under Tasks. Click the weblog entry title.
   A For Your Approval window appears.

2. Click the title of the entry to review the text.

3. Click the Approved button.

**Adding comments to entries**

To provide feedback or commentary on a weblog entry, you can add a comment to it.

To add a comment:

1. Locate and open the weblog entry to which you want to add a comment.

2. Click the Add a Comment link.

3. In the Title field, enter a comment title.

4. In the Description field, enter the comment text.

5. Click Apply.

**Viewing comments**

To view comments:

1. Locate and open the weblog.
   The weblog entries display. A Comments link appears for an entry that includes comments.

2. Click a Comments link.
   The comments display in reverse chronological order and include the name of the user who posted the comment.
Deleting comments

If you are the user who added the comment or the user who added the entry, you can delete the comment.

To delete a comment:

1. Locate and open the weblog entry that includes the comment you want to delete.
2. Click the comment title.
3. From the More Actions menu, select Delete.
   The Confirm Delete page appears.
4. Click Delete to remove the comment.

Adding a wiki

A wiki allows users to publish content quickly and easily on the web. Using a web browser and either the built-in WYSIWYG (What You See Is What You Get) editor or simple wiki syntax, you can add and link web pages and edit content instantly. Wikis are well-suited for any type of project that requires collaborative writing.

By default, you use the WYSIWYG editor to create wiki content. Your user account property Text Composition Format specifies whether to use the WYSIWYG editor (Rich Text) or wiki syntax (Plain Text). Should you want to use wiki syntax, change the Text Composition Format property or, after adding the wiki, deselect the wysiwyg checkbox on the Add WikiPage. Once you have selected the editing method, you should continue to use it after adding the page.

To get started, you first add a wiki to a collection or workspace and then add content to it.

To add a wiki:

1. Navigate to and open the container to which you want to add a wiki.
2. From the Add menu, select Wiki.
   The Add Wiki page appears.
3. In the Title field, enter a name for the wiki. The name can contain spaces and punctuation marks.
4. Enter any optional information. Click a field name for a description of each property. To add interwiki links, see Using interwiki links.

   Note: If your Administrator created custom properties, they also display on the page. See your Administrator for information about custom properties.
5. Click Apply.
   The wiki is added to the container.

Note: When you create a wiki using a custom theme, that theme is used to display wiki pages. Any theme you select on your User Properties page has no effect on the wiki pages. When you create a wiki using a default or clean theme, the theme you select on your User Properties page is used to display wiki pages.
Adding content to a wiki

You add content to the wiki by editing the wiki home page, creating, and linking additional wiki pages, inserting images, and attaching documents.

By default, each wiki page includes a WYSIWYG editor for easy formatting of content. Alternatively, you can use the wiki syntax provided in a sidebar on a wiki page. However, when editing a wiki page, you should use the same method you used to create the page.

Adding content to the wiki home page

After adding the wiki, your first step is to add content to the home page.

To add content to the home page:

1. Locate and open the wiki to which you want to add content.
   The Add WikiPage appears and the page is titled HomePage.
2. In the Description field, enter the page content using one of the following methods:
   – Use the WYSIWYG editor. The editor appears when your user account property Text
     Composition Format is set to Rich Text and the wysiwyg checkbox is selected on the Add
     WikiPage.
   – Deselect the wysiwyg checkbox. Use the wiki syntax displayed in the sidebar.
     
     Note: When using wiki syntax, HTML tags are used on the page. When you want to include
     angle brackets on the page, either use the WYSIWYG editor or type &lt;text&gt; to have the angle
     brackets and text appear. Similarly, to have the ampersand character (&) appear, type &amp;.

3. Click Apply.
   The wiki home page appears with your content.

Linking pages to a wiki

You can add any number of web pages to the wiki. You first add the link to the page and then enter content on the page.

To link a page to the wiki:

1. Open a wiki page and click Edit This Page.
2. On the Edit Wiki page, enter the new page name between double square brackets.
   Example: [[New Wiki Page]]
3. Click Apply.
   The page appears displaying the page name you entered followed by a question mark.
4. Click the page name.
   The Add WikiPage appears.
5. In the Description field, enter the page content using either the WYSIWYG editor or wiki syntax.
6. Click Apply.
The pages are linked.

**Note:** To list the pages linked to a wiki page, view the wiki page, and click Backlinks. The linked pages are listed on the Search Results page.

**Inserting images**

On a wiki page you can insert an image that is located on an external URL or on the same DocuShare server.

To insert an image on a wiki page using the WYSIWYG editor:

1. Do one of the following:
   - To insert an image located on an external URL, select the text to link to the image and click the **Insert/Edit Link** button on the WYSIWYG bar. Enter the complete URL to the image and click **Insert**.
   - To insert an image located on the same DocuShare server, enter `{image:Document-#}`. The pound symbol (#) represents a number.
2. Click **Apply**.

To insert an image on a wiki page using wiki syntax:

1. Do one of the following:
   - To insert an image located on an external URL, enter `{image:url}`.
   - To insert an image located on the same DocuShare server, enter `{image:Document-#}`. The pound symbol (#) represents a number.
2. Click **Apply**.

**Attaching documents**

On a wiki page you can add a link to a document that you upload to DocuShare.

To attach a document to a wiki page:

1. Open a wiki page and click **Attach**.
   The Add Document page appears.
2. Enter the complete path and filename of the document in the **Filename** field or click the **Browse** button to navigate to and select the document.
3. In the **Title** field, enter a document name.
4. Click **Apply**.
5. On the wiki page, click **Edit This Page**.
6. On the Edit Wiki page, enter the document name that you used in step 3 between double square brackets.
   **Example:** For more information, see our [[brochure]].
7. Click **Apply**.
Using interwiki links

The use of interwiki links allows you to create links to external wiki sites on your wiki pages without typing or pasting URLs. Before adding the links to your wiki pages, you must map each wiki name to its URL.

To use interwiki links:
1. Locate the wiki and click its Properties icon.
2. Click the Edit link.
3. Under Inter Wiki Links, enter the following:
   - Inter Wiki Name—The name to enter when creating the link on the wiki page. Example: wikipedia.
4. To add another interwiki link, click the plus sign (+).
5. If you need to remove an interwiki link, click the trashcan located to the right of the link.
6. To create a link on a wiki page, edit the page by entering [[page title@wiki name]]. Example: [[Italy@wikipedia]].

Renaming wiki pages

To rename a wiki page:
1. Locate and open the wiki page that you want to rename.
2. Click Rename This Page.
3. In the Title field, enter a new name; then click Rename.
4. On the confirmation page, click OK.

Note: You cannot rename the wiki home page.

Printing wiki pages

You can print some or all your wiki pages to review the content on the pages or to have a printed copy of the wiki.

To print wiki pages:
1. Locate and open the homepage of the wiki that you want to print.
2. Click Printable View.
   The view displays the top two levels of the wiki, with the homepage as the top level, or level one.
3. To view other wiki pages, do any of the following:
   - To remove one level of pages from the view, click Subtract One Level.
   - To add one level of pages to the view, click Add One Level.
– To display all levels of pages, click **Show All Levels**. When viewing all levels, you can click **Show Two Levels** to view the top two levels of the wiki.

4. Use the **Print** command from the **File** menu to print the wiki view.
9. Automating work processes

Routing documents

During a document’s development cycle, you often need to solicit feedback from others, receive approval of the document’s content, or simply share the information in the document. DocuShare enables you to automate the routing of documents to users and request a specific action after the users receive the documents.

On a form called a Routing Slip, you indicate the users to whom the document should be sent, the type of action you want the users to take, and a message describing the document task. You then submit the Routing Slip; DocuShare notifies the specified users of the document task. While a task is in progress, you can monitor its status.

Creating a routing task

You can route an existing document on your site, or you can choose to route a document when adding it to DocuShare. In addition, you can route an individual document version. On the Routing Slip that accompanies the document, you can request users to approve the document, review the document and provide changes, or acknowledge receipt of the document, or you can provide the document for information only.

When creating a routing task, you can define a single routing step or several sequential steps. A single routing step consists of one type of action, such as sending a document to users for approval. A multi-step routing task enables you to automate a document process. For example, you can create a routing task to send a document to a group of users for their review and comment before sending the revised document for approval.

To route a document:

1. Do one of the following:
   - To route a single document, locate the document that you want to route and select Route from the More Actions menu. The Route command does not appear if the document is locked.
   - To route a single document version, go to the document’s Version History page, locate the document version that you want to route and click its Route icon. The Route icon does not appear if the document is locked.
   - To route several documents, locate the documents and click the checkbox next to each document. From the Edit Selected menu, select Route. On the Confirmation page, click Confirm.
   - To route a document after adding it to DocuShare, select Document from the Add menu. Enter the required information and click Publish and then route the document before clicking Apply.
To route a document before it appears in DocuShare, select Document from the Add menu. Enter the required information and click Route the document and publish it later before clicking Apply.

A Routing Slip appears.

2. If you want to include another document, click the Add button. Locate the document and click its Route command; then confirm adding the document to the Routing Slip.

3. If you want to use a saved Routing Slip, do one of the following and then go to step 19:
   – Select one of your saved Routing Slips and click Load.
   – Click View all Saved Routing Slips to display your saved Routing Slips and the public Routing Slips saved by all site users. Select a Routing Slip.

4. Under Routing Action, choose one of the following:
   – Approve or Disapprove—Requires users to approve or not approve the document. Click Allow recipients to make changes if you want to let a recipient upload a new document to replace the original one. Click Make version approved by all the preferred version if you want the version all recipients approved to be the new preferred version.
   – Review and Make Changes—Allows users to provide comments and a revised version of the document. Click Share changes with recipients if you want each recipient to see the previous recipient’s changes. Click Return to initiator after review if you want to publish a revised document as the preferred version when the review is complete.
   – Acknowledge Receipt—Provides the document to users for information and requires the users to confirm receiving the document.
   – Information—Provides the document to users for information only.

5. Depending on the routing action you selected, choose one of the following Routing Orders:
   – In Order—Routes the document to users in the order in which they are listed in the Selected Users/Groups field. If a user does not approve the document, it is not routed to subsequent users.
   – At the Same Time-Single Reply—Routes the document to all users simultaneously and only one user’s reply is needed to complete the routing task.
   – At the Same Time-All Reply—Routes the document to all users simultaneously and all users must reply to complete the routing task. However, if one user does not approve the document, it is not routed to other users.
   – At the Same Time-Majority Reply—Routes the document to all users simultaneously and more than half of the users must reply to complete the routing task.

6. Under Routing Message, do the following:
   – In the Subject field, enter a brief topic that appears in the notification or email that the user receives.
   – In the Comments field, enter a message.

7. Click Next to go to the Add Recipients page.

8. In the Show field, select the type of account you want to display in the Possible Users/Groups field.

9. Do one of the following:
To find a specific account, enter part of the user’s first name, last name, or username or the group’s title in the Search field. Click the Go button.

To list all accounts, click Show All (if displayed).

To display your favorite accounts, click Show Favorites.

10. In the Possible Users/Groups field, select the accounts to add to the list of recipients and click the Add button. To select multiple accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

11. In the Selected Users/Groups field, select any accounts that you want to remove from the list of recipients and click the Remove button.

12. To display the members in a group, select the group in the Selected Users/Groups field and click Show Group Members. The group members replace the group title and the routing task is sent to each user and not to the group.

13. To reorder the recipients in the Selected Users/Groups field, select an account and do one of the following:
   - To move the recipient before another recipient, click Move Up.
   - To move the recipient after another recipient, click Move Down.

14. Click Next to go to the Choose Escalation and Notification page (the page does not appear if you are routing the document for information).

15. Select If Not Complete and do the following:
   - To specify a completion date, select By and enter a date or select Within and specify a time period.
   - To specify an escalation action if the routing task is not complete by the specified date, choose an action from the Then Escalate menu.

16. Under Notify Me, choose any of the following:
   - Of Escalation—Notifies you of the escalation action.
   - Of Task Progress—Notifies you of the routing status after each user action.
   - When Task Is Complete—Notifies you when each routing step is complete.

To check for notifications, click the My Tasks link on the navigation bar and select Tasks Assigned to Me.

17. Click Done and review the routing information for the task on the Routing Step Review page.

18. To save the Routing Slip, click Save Routing Slip. Enter a name for the Routing Slip and keep Save as private selected if you do not want to share the Routing Slip with other users. Then click OK.

19. Do one of the following:
   - Click Submit to start the routing task.
   - Click Back to change any of the routing information.
   - Click Add Step to add another step to the routing task.

Note: If you chose Route the document and publish it later in step 1, you must publish the document for it to appear in DocuShare.
Setting up a collection for routing documents

You can have any document added to a collection automatically routed by associating one of your saved, private Routing Slips with the collection.

To use a Routing Slip with a collection:
1. Locate the collection you want to use for routing documents.
2. Click the Properties icon that appears to the right of the collection’s title.
3. Click the Edit link.
4. In the Route Before Publishing field, select Yes to route the document before it is added to the collection.
5. In the Use Routing Slip field, select the Routing Slip that you want to use.
6. Click Apply.

Checking the status of routing tasks you assigned

You can check the status of completed and pending routing tasks that you assigned to other users. Once a task is complete, you can choose to delete it, keep a record of it, or publish the document to add it to DocuShare.

To check the status of a routing task:
1. Do one of the following:
   – On the navigation bar, click My Tasks.
   – On the navigation bar, click My DocuShare. Then click Tasks.
   The My Tasks window appears.
2. From the Show menu, select Tasks Assigned by Me.
   The page lists the routing tasks, under Description, the date the task began, and the status. The Task status table below describes the status information.
## Task status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The single-step task or one step of a multi-step task is complete, and the recipients approved the documents.</td>
</tr>
<tr>
<td>Disapproved</td>
<td>The single-step task or one step of a multi-step task is complete, and the recipients did not approve the documents.</td>
</tr>
<tr>
<td>Reviewed</td>
<td>The single-step task or one step of a multi-step task is complete, and the recipients reviewed the documents.</td>
</tr>
<tr>
<td>Acknowledged</td>
<td>The single-step task or one step of a multi-step task is complete, and the recipients acknowledged receiving the documents.</td>
</tr>
<tr>
<td>Delivered</td>
<td>The single-step task or one step of a multi-step task is complete, and the recipients received the documents for their information.</td>
</tr>
<tr>
<td>All Steps Completed</td>
<td>The multi-step task is complete.</td>
</tr>
<tr>
<td>Started</td>
<td>The task is pending. It is currently being routed to all recipients at the same time for approval, review, or acknowledgment.</td>
</tr>
<tr>
<td>Username</td>
<td>The task is pending. It is currently being routed to all recipients in order; the user whose name is displayed has received the document but has not taken any action.</td>
</tr>
<tr>
<td>Step #</td>
<td>The task is pending and is on a specific step of a multi-step task.</td>
</tr>
<tr>
<td>Step #: Username</td>
<td>The task is pending and is on a specific step of a multi-step task. It is currently being routed to all recipients in order; the user whose name is displayed has received the document but has not taken any action.</td>
</tr>
<tr>
<td>Overdue</td>
<td>For a single-step task or one step of a multi-step task that is overdue, the word Overdue appears after the task’s description.</td>
</tr>
<tr>
<td>Terminated</td>
<td>The task is stopped because it cannot continue. This can occur when Cancel Task is set for Then Escalate or when a document or user is deleted from your site.</td>
</tr>
</tbody>
</table>

3. To view more information about the task, click the task’s description. A Report on Routing window appears, which displays the status of each user assigned the task.

4. Do one of the following:
   - To view an individual recipient’s comments, click the user’s name.
   - To view all recipient comments, click Show all User Comments. If you want, you can save the comments to a text file.

Close the window after viewing the comments.
5. To view the user’s changes to the document, click the document’s title.
6. Close the document after viewing the changes.
7. If the task is complete, do one of the following:
   – To move a task from the Tasks Assigned by Me list to your Deleted Tasks, click Delete This Job.
   – To complete the task later, click Keep for Later. The task remains in the Tasks Assigned by Me list.
   – To publish a document that has not been added to DocuShare (the word Unpublished appears after the document’s title), click the Properties icon that appears to the right of the document’s title. At the bottom of the View Properties page, click the Publish This Version button.

Viewing progress reports

If you chose to be notified of a task’s progress, completion, or overdue status on the Routing Slip, you can view the notifications in the Routing Tasks window.

To view a task’s progress report:
1. Do one of the following:
   – On the navigation bar, click My Tasks.
   – On the navigation bar, click My DocuShare. Then click Tasks.
   The My Tasks window appears.
2. From the Show menu, select Tasks Assigned to Me.
   The page lists the routing tasks, under Description, the date the task was assigned, and the type of report. The Report type table below describes the report types.

<table>
<thead>
<tr>
<th>Report type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response</td>
<td>The recipient responded to the task.</td>
</tr>
<tr>
<td>Completion</td>
<td>The task is complete.</td>
</tr>
<tr>
<td>Overdue</td>
<td>The task is in progress past the completion date.</td>
</tr>
<tr>
<td>Termination</td>
<td>The task is stopped because it cannot continue. This can occur when a document or user is deleted from your site.</td>
</tr>
</tbody>
</table>

3. To view a task’s progress report, click its Description.
   A window appears, which includes the routed document and displays the user’s comments.
4. To view the user’s changes to the document, click the document’s title.
You can save the user’s revised document as a new version of your routed document. See the next section, **Publishing a new version of your routed document**.

5. Close the document after viewing the changes.

6. In the Response to Routing window, do one of the following:
   - To schedule a new due date for an overdue task, enter a new date in the **Due Date** field and click the **Acknowledged** button.
   - To confirm reviewing the report, click the **Acknowledged** button.
   - To review the report later, click the **Acknowledge Later** button.

**Publishing a new version of your routed document**

If you routed a document for review, you could save a document that a recipient changed as a new version of your routed document. In the For Your Review window, the word New appears after the title of a document that a recipient changed.

To publish a new version of your routed document:

1. In the My Tasks window, select **Tasks Assigned by Me**.
2. Under **Description**, click the task that includes the changed document.
3. In the Report on Routing for Review window, click the name of the recipient who provided the changed document.
4. Click the document title to open it.
5. Save the document to a location on your computer, and then close the document window.
6. In the Report on Routing for Review window, click the **Close** button.
7. Click the **Properties** icon that appears to the right of the document’s title.
8. At the bottom of the View Properties page, click the **Publish New Version** button.
9. On the Add Version page, click the **Browse** button.
10. Navigate to the location on your local drive in which you saved the document in step 5, select it, and click **Open**.
    
    The path to the document appears in the **Filename** field.

11. Optionally, change the document title and add a version comment.
12. Click **Apply**.
13. If a document version other than the latest is the preferred version, you are asked if you would like to set this version as the preferred version. Click **Yes** to change the preferred version; otherwise, click **No**.
    
    For more information on document versions and the preferred version, see **Managing document versions**.

14. Click the **Report on Routing for Review** link in the **Location** path.
15. In the Report on Routing for Review window, do one of the following:
   - To move the task from the **Tasks Assigned by Me** list to your **Deleted Tasks**, click **Delete This Job**
Changing the preferred document version when the review is complete

If you routed a document for review and selected Return to initiator after review, you can change the preferred version to a document that a recipient uploaded or to a new document that you upload.

To change the preferred document version:
1. In the My Tasks window, select Tasks Assigned to Me.
2. Under Description, click the task name.
3. In the For Your Review window, click the document’s title.
   The document opens in its native editor or a window appears allowing you to download the document.
4. Review the document.
5. To upload a new document, do the following:
   a. Click the Add Draft Version icon that appears to the right of the title of the document you routed.
   b. On the Add Version page, click the Choose File button.
   c. Navigate to and select the document you want, and then click Open.
   d. Optionally, change the document title and add a version comment.
   e. On the Add Version page, click Apply.
   f. On the View Properties page, click the For Your Review link in the Location path.
6. Under Next Version, click the radio button next to the document you want to set as the preferred version.
7. Click the Make This the Preferred Version checkbox.
8. Do one of the following:
   a. To complete the task and remove it from the Tasks Assigned to Me list, click the Reviewed button.
   b. To not complete the task at this time, click the Review Later button. The task remains in the Tasks Assigned to Me list.

Viewing the tasks assigned to you

The tasks assigned to you display in the My Tasks window or on My DocuShare. If you chose to receive an email message when a new task is assigned to you, the message includes a URL to the task.

Note: To receive an email message when a new task is assigned to you, your user account property Routing Task Notification must be set to Email, and your email address must appear in the Email Address field.

To view the tasks assigned to you:
1. Do one of the following:
On the navigation bar, click My Tasks. Select Tasks Assigned to Me. Any task marked Request is a task assigned to you.

On the navigation bar, click My DocuShare. The tasks assigned to you display under Tasks.

2. Click a task to view it.
A window appears displaying your task. The following sections describe how to respond to routing tasks.

**Approving or disapproving a document**
1. In the For Your Approval window, do one of the following:
   - Click the document’s title to view it. The document opens in its native editor or a window appears allowing you to download the document. When your review is complete, close the document.
   - Click the Check Out and Download icon to edit the document. Download the document, make the changes you want, and then upload a new version. Unlock the document by clicking the Unlock icon.
   - Click the Add Version icon to add a new version of the document. In the Add Version window, choose the document you want to add and click Apply.

   **Note:** If the document version sent to you is not the latest version, a Latest published version link is included. You can click the link to view the latest version of the document.

2. You can repeat step 1 for each routed document.
3. In the Comments field, enter an optional message.
4. Click Save as private if you do not want other recipients to view your comments.
5. Do one of the following:
   - To complete the task and approve the document, click the Approved button. The task is removed from the Tasks Assigned to Me list.
   - To complete the task but not approve the document, click the Disapproved button. The task is removed from the Tasks Assigned to Me list.
   - To not complete the task at this time, click the Respond Later button. The task remains in the Tasks Assigned to Me list.

**Reviewing a document**
1. In the For Your Review window, click the document’s title.
   The document opens in its native editor or a window appears allowing you to download the document.

   **Note:** If the document version sent to you is not the latest version, a Latest published version link is included. You can click the link to view the latest version of the document.

2. Review the document and make any changes you want.
3. Close the document and, if you made changes, save it to a location on your computer.
4. If you changed the document, do the following:
   a. Click the Properties icon that appears to the right of the document’s title.
b. At the bottom of the View Properties page, click the Add Draft Version button.

c. On the Add Version page, click the Browse button.

d. Navigate to and select the document you changed, and then click Open.

e. Optionally, change the document title and add a version comment.

f. On the Add Version page, click Apply.

g. On the View Properties page, click the For Your Review link in the Location path.

5. You can repeat steps 1 through 4 for each routed document.

6. In the Comments field, enter an optional message.

7. Click Save as private if you do not want other recipients to view your comments.

8. Do one of the following:
   – To complete the task and remove it from the Tasks Assigned to Me list, click the Reviewed button.
   – To not complete the task at this time, click the Review Later button. The task remains in the Tasks Assigned to Me list.

Acknowledging receipt of a document
1. In the For Your Acknowledgment window, click the document’s title.
   The document opens in its native editor or a window appears allowing you to download the document.

   **Note:** If the document version sent to you is not the latest version, a Latest published version link is included. You can click the link to view the latest version of the document.

2. When you are finished viewing the document, close it.

3. You can repeat steps 1 and 2 for each routed document.

4. Do one of the following:
   – To complete the task and remove it from the Tasks Assigned to Me list, click the Acknowledged button.
   – To not complete the task at this time, click the Acknowledge Later button. The task remains in the Tasks Assigned to Me list.

Removing a document sent for information
1. In the For Your Information window, click the document’s title.
   The document opens in its native editor or a window appears allowing you to download the document.

   **Note:** If the document version sent to you is not the latest version, a Latest published version link is included. You can click the link to view the latest version of the document.

2. When you are finished viewing the document, close it.

3. You can repeat steps 1 and 2 for each routed document.

4. Do one of the following:
– To complete the task and remove it from the Tasks Assigned to Me list, click the **Remove** button.
– To not complete the task at this time, click the **Remove Later** button. The task remains in the Tasks Assigned to Me list.

**Viewing your deleted tasks**

After you delete a completed task that you assigned by clicking the **Delete This Job** button, DocuShare saves the task. This provides you with a record of the completed routing tasks you assigned.

In addition, you can view the deleted routing tasks of a specific document. See *Viewing the routing tasks of a document*.

To view all your deleted tasks:

1. Do one of the following:
   – On the navigation bar, click **My Tasks**.
   – On the navigation bar, click **My DocuShare**. Then click **Tasks**.
2. In the My Tasks window, select **Deleted Tasks**.
   Your deleted routing tasks display.

**Viewing the routing tasks of a document**

The routing task owner and each recipient can view the routing status of a document or any of its versions on the Routing page for the document. The page displays both tasks in progress and deleted tasks.

To view a document’s routing tasks:

1. Do one of the following:
   – Locate the document whose tasks you want to view.
   – Open a routing report or request window that contains the document whose tasks you want to view.
2. Click the **Properties** icon that appears to the right of the document’s title.
   The View Properties page appears.
3. Click the **Routing** link.
   The tasks and their status display.

**Workflow Reporting**

Workflow Reporting searches DocuShare workflows which meet certain filtering criteria. The criteria that can be specified include the collections where the route document is located, workflow title, route status and date range.
Accessing Workflow Reporting

The Workflow Reporting link (http://<DocuShareServerHostNameAndPort>/docushare/jsp/workflowreporting/WFReport.jsp) is provided on the DocuShare home page under Other Links.

Workflow Reporting Search Criteria

Once the Link is selected, the Search page displays. Only the users belonging to the group as identified in the Workflow Reporting General Group file can access this page. An error message appears if the user has no access rights to this page.

Field Description on Workflow Reporting Search Page

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Input Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Edit Box</td>
<td>Text string to search</td>
<td>Allows the user to enter the text string to search for matching collection by collection title. Wildcard search (*, ?) is allowed.</td>
</tr>
<tr>
<td>Go</td>
<td>Button</td>
<td>Selectable</td>
<td>On select, the collections which match the search string entered in the &lt;Search&gt; Edit box is displayed in the &lt;Possible Location(s)&gt; text box.</td>
</tr>
<tr>
<td>Show Favorites</td>
<td>Button</td>
<td>Selectable</td>
<td>On select, the favourite Collections for the login user is displayed in &lt;Possible Location(s)&gt; .</td>
</tr>
<tr>
<td>Possible Location(s)</td>
<td>Text Box</td>
<td>List of Collections “Collection Title(Collection Handle)”</td>
<td>Display the possible collections the user has read access that can be added to &lt;Selected Location(s)&gt; . DocuShare root collections are displayed when the page is first loaded.</td>
</tr>
<tr>
<td>Add</td>
<td>Button</td>
<td>Selectable</td>
<td>Add the collection(s) selected in &lt;Possible Location(s)&gt; to &lt;Selected Location(s)&gt; .</td>
</tr>
<tr>
<td>Remove</td>
<td>Button</td>
<td>Selectable</td>
<td>Remove the collection(s) selected in &lt;Selected Location(s)&gt; and put it back to &lt;Possible Location(s)&gt; .</td>
</tr>
<tr>
<td>Selected Location(s)</td>
<td>Text Box</td>
<td>List of Collection Title(Collection Handle)</td>
<td>List the collection(s) to search recursively for workflow with routing documents. If no selected location is specified when &lt;Search Workflow&gt; button is pressed, the following error message is displayed. “No location selected. Please add Selected Location(s) to search.”</td>
</tr>
<tr>
<td>Workflow Title</td>
<td>Edit Box</td>
<td>Text string</td>
<td>Allow searching by Workflow title. Wildcard(*, ?) are supported.</td>
</tr>
</tbody>
</table>

The asterisk(*)
The asterisk represents any number of unknown characters. For example, if cheese* is entered as the search term, the search might return these items: cheese cheesecake cheeses dip
If *cheese is entered as the search term, the search might return these items: stringcheese swisscheese slicedcheese

The question mark (?)
Field Description on Workflow Reporting Search Page

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Input Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The question mark represents only one unknown character. For example, if take?out is entered as the search term, the search might return these items: take1out takenout take2out</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Route Status</td>
<td>Combo Box</td>
<td>All, Active, Approved, Disapproved</td>
<td>Allow searching by Route Status.</td>
</tr>
<tr>
<td>Date Range</td>
<td>Combo Box</td>
<td>All, On or After, On or Before</td>
<td>Allow searching by Date Range.</td>
</tr>
<tr>
<td>Search Workflow</td>
<td>Button</td>
<td>Selectable</td>
<td>When search button is selected, it starts searching and displays the workflow which meet the search criteria in the Essar Steel Workflow Search Results Page.</td>
</tr>
</tbody>
</table>

Workflow Search Results Page

When the Search Workflow button is selected, the workflow search starts its search. If there are workflows which meet the Search criteria, these workflows are displayed in the Workflow Search Results Page. The header of the window displays a button to allow the user to select Another Search Workflow.

The search criteria selected is displayed in the Search Results page in the Web browser. The <Selected Location(s)> displays the title of the selected collections, which when selected, opens the view Collection Page (http://<IP address>:<Port>/docushare/dsweb/View/<Collection Handle>).

If there is nothing found to be displayed, the window displays a button to allow the user to select Another Search Workflow. It displays the Search results searched for, as well as a Nothing found to display.

A paging feature is supported. The number of items found is displayed, and each page can display up to 20 items(rows) found. [First/Prev], 1,2,3,…, [Next/Last] buttons are available for navigating purpose. The table can also be sorted in ascending or descending order by selecting the heading of each column.

The bottom of the window displays Export options to indicate that the user can save the search results to either a CSV formatted file or to an Excel Spreadsheet format by selecting the appropriate hyperlink.

Selecting either prompt the user “Do you want to open or save WorkflowReport.CSV (size) (or Workflow.XLS (size)) from the IP address. The user can select Open, Save or Cancel.

Workflow Search Results Column Fields

<table>
<thead>
<tr>
<th>Column</th>
<th>Column Name</th>
<th>Description</th>
<th>CSV/Excel Export or Value Displayed on UI</th>
<th>Link (When select value displayed on UI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Workflow ID</td>
<td>The ID of the workflow.</td>
<td>60</td>
<td>ListWorkflowDetailPage for the WorkflowID. (require Administrator privilege to access this link.)</td>
</tr>
</tbody>
</table>
### Search Result Fields

<table>
<thead>
<tr>
<th>Column</th>
<th>Column Name</th>
<th>Description</th>
<th>CSV/Excel Export or Value Displayed on UI</th>
<th>Link (When select value displayed on UI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>Workflow Title</td>
<td>The title of the Workflow. If the Workflow title is empty, the <code>&lt;EmptyWorkflowTitle&gt;</code> string (Default is &quot;--none--&quot;) defined in config file is displayed/save to CSV/Excel file.</td>
<td>Workflow_5 Subject</td>
<td>Link to the &lt;Report on Routing for Review&gt; Page for the Workflow. (Following message is displayed “You cannot view the document’s routing status because you are not a routing task recipient.” if the user has no access to the workflow)</td>
</tr>
</tbody>
</table>
| 3.     | Path to Workflow             | The path to workflow (Breadcrumbs). Full path is saved to CSV/Excel file. Up to 40 characters plus ... is displayed. If the current user has no access to a collection in the path, it is displayed as "-- hidden--". The string to display is configurable through config file. | Case when user has access to the collections listed:  
  **Csv/Excel:** Initial Top Level Collection B >> Test Team >> Test Employee Information  
  **Display:** Initial Top Level Collection B >> Test ...  
  Case when user has no access to “Test Team” collection listed:  
  **Csv/Excel:** Initial Top Level Collection B >> -- hidden-- >> Test Employee Information  
  **Display:** Initial Top Level Collection B >> -- hidden-- ... | - |
| 6.     | Route Owner                  | The owner of the workflow. Format: Last Name, First Name.                                             | Tam, John                                | Link to the Property Page of the Route Owner. |
| 7.     | Workflow Submission Date     | The Workflow submission date. The date format used is defined in config file. (Default is yyyy-MM-dd) | 2012-04-30                               | - |
| 8.     | Current Status               | The current workflow status.                                                                          | Active                                   | - |
Search Result Fields

<table>
<thead>
<tr>
<th>Column</th>
<th>Column Name</th>
<th>Description</th>
<th>CSV/Excel Export or Value Displayed on UI</th>
<th>Link (When select value displayed on UI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.</td>
<td>Task Received Date</td>
<td>The date the approver assigned the task.</td>
<td>2012-04-30</td>
<td>.</td>
</tr>
</tbody>
</table>

Workflow Search Results with Multiple Documents & Multiple Approvers

For WorkflowID with multiple documents and multiple approvers, it is displayed in as MxN items. For example, the search could display Workflow ID 901 and its Workflow Title as Route 3 Documents & Two Users and Path to Workflow. However there can be a multitude of Routed Document Titles with their associated properties.

Using content rules

A content rule allows you to have an action run automatically when a specific event occurs. For example, you can create a content rule for a collection to route any document added to the collection. Or, you can create a content rule for a document to have an email message sent when a new version of the document authored by a specific user is added. You can add a content rule for any object on your site.

You can have an action run when any of the events described in the Events table below occur.

Events

<table>
<thead>
<tr>
<th>Event Name</th>
<th>When Event Occurs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any change</td>
<td>Any one of the changes listed in this table.</td>
</tr>
<tr>
<td>Document locked or checked out</td>
<td>The document is locked or checked out for editing.</td>
</tr>
<tr>
<td>Document unlocked</td>
<td>The document is unlocked.</td>
</tr>
<tr>
<td>Lifecycle management</td>
<td>A policy event occurs. For more information on creating content rules for lifecycle management events, see the guide Xerox Lifecycle Manager for DocuShare.</td>
</tr>
<tr>
<td>Location edited</td>
<td>The location of an object is changed, using either the Locations page or copy/cut and paste.</td>
</tr>
<tr>
<td>New document version added</td>
<td>A document is updated with a newer version.</td>
</tr>
</tbody>
</table>
Events

<table>
<thead>
<tr>
<th>Event Name</th>
<th>When Event Occurs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner changed</td>
<td>The owner of an object is changed. <strong>Note:</strong> When changing the owner of a document, you can optionally change the owner of the document versions; when changing the owner of a container, you can choose how to change the owner of the container and its contents. Therefore, the owner change can be the result of how the change is applied.</td>
</tr>
<tr>
<td>Permissions changed</td>
<td>The permissions of an object are changed. <strong>Note:</strong> When changing the permissions of a document, you can optionally change the permissions of the document versions; when changing the permissions of a container, you can choose how to change the permissions of the container and its contents. Therefore, the permissions change can be the result of how the change is applied.</td>
</tr>
<tr>
<td>Properties edited</td>
<td>The properties of an object are changed.</td>
</tr>
<tr>
<td>Routing</td>
<td>A change occurred to the status of a routing task.</td>
</tr>
<tr>
<td>Something added</td>
<td>A new object is added to a container, using either the Add menu or copy/cut and paste.</td>
</tr>
</tbody>
</table>

Creating a content rule

DocuShare provides a wizard to guide you in creating a content rule. Using the wizard, you provide a brief description of the content rule, select the event that triggers the action, select the action to run, and enter settings specific to the selected action.

To create a content rule:

1. Locate the object for which you want to create a content rule.
2. Do one of the following:
   - Click the object’s Content Rules icon.
   - Click the object’s Properties icon. Then click the Content Rules link.
3. On the Content Rules page, click **Create a New Content Rule**.
   The Create a New Content Rule wizard appears. The following steps describe the required fields. For information about any of the optional fields in the wizard, click the appropriate field name.
4. On the Description page, enter a **Title** for the content rule and click **Next**.
5. On the Event Triggers page, select the event that causes the action to run.
6. If the object is a container (collection, calendar, etc.), select one of the following choices from the Event Applies To menu. Then click **Next**.
This container and immediate contents—Triggers the action when the event occurs to the container and only its first nested level of objects.

For example, if a collection contains several objects and a sub collection, the action is triggered when the event occurs to any of the objects and the subcollections; the action is not triggered when the event occurs to an object in the sub collection.

This container and all levels of contents—Triggers the action when the event occurs to the container and all the objects under it.

For example, when the event occurs to any object in a collection regardless of its nested level, the action is triggered.

Note: Your Administrator sets the maximum number of objects DocuShare examines to determine if the event occurred. The default is 30,000 objects.

7. On the Content Property Conditions page, refine the event trigger by specifying property conditions. Then click Next.

8. On the Action Performed page, select the action to run when the event occurs and click Next.

The Action Settings page appears. The options on the page vary depending on the action you selected in the previous step. Click an option name for a description of its usage.

9. Enter the appropriate information and click Next.

10. On the Completion Settings page, you can choose to set a property value on the object when the content rule completes. In addition, you can append the property value to any existing property values. Then click Done.

The View Properties page for the content rule appears and provides a summary of the content rule.

Changing content rules

At any time after creating a content rule, you can change its settings.

To change a content rule:

1. Locate the object whose content rule you want to change.

2. Do one of the following:

   – From the object’s More Actions menu, select Content Rules.

   – Click the object’s Content Rules icon.

   The Content Rules page lists the object’s current content rules.

3. Do one of the following:

   – Click the Properties icon that appears to the right of the content rule.

   – Click the title of the content rule.

   The View Properties page provides a summary of the content rule.

4. Click the Edit link.

5. On each Edit Content Rule page, make the changes you want and click Next.

6. On the last page, click Done.
Deleting a content rule

Depending on how your site is set up, a deleted content rule can go to either your personal trashcan on My DocuShare or the site-wide trashcan. Contact your Administrator to find out which trashcans are used on your site. If you have a personal trashcan, you can restore an object from it if your Administrator has not expunged the object from the site-wide trashcan. See Using personal home page for more information.

To delete a content rule:
1. Locate the object whose content rule you want to delete.
2. Do one of the following:
   - From the object’s More Actions menu, select Content Rules.
   - Click the object’s Content Rules icon.
   The Content Rules page lists the object’s current content rules.
3. Click the Delete icon for the content rule that you want to delete.
   The Confirm Delete page appears.
4. Click Delete.

Managing site content rules

From a single location, the Content Rules Management page, you can view, edit, delete, and copy site content rules.

To access, edit and delete content rules on your site:
1. On the DocuShare home page, click Content Rules Management under Other Links.
   All the content rules on your site display.
2. To view the settings of a specific content rule, do one of the following:
   - Click the title of the content rule.
   - Select Properties from the content rule’s More Actions menu.
3. To change the settings of a specific content rule, do the following:
   a. Click the title of the content rule.
   b. Click the Edit link and then make the changes you want.
4. To delete a specific content rule, select Delete This Content Rule from the content rule’s More Actions menu.

Copying content rules

You can easily copy a content rule to another object of the same type. For example, you can copy a content rule that a user created for a collection to use for one of your collections. This eliminates the need to manually replicate a content rule.

To copy a content rule:
1. On the Content Rules Management page, click the **Duplicate Content Rule** icon for the content rule that you want to copy.

2. In the **Sort By** field, select **Title** to display the possible objects in alphabetical order or select **Handle** to display the possible objects in numerical order.

3. Do one of the following:
   - To find specific objects, enter any part of an object title in the **Search** field. Click the **Go** button.
   - To list all objects, click **Show All** (if displayed).

4. In the **Possible Objects** field, select the objects that you want to copy the content rule to and click the **Add** button. To select multiple objects, use the Ctrl key (Windows) or the Command key (Macintosh).

5. In the **Selected Objects** field, select any objects that you do not want to copy the content rule to and click the **Remove** button. To select multiple objects, use the Ctrl key (Windows) or the Command key (Macintosh).

6. Click **Duplicate Content Rule**.

   The copied content rules display on the Content Rules Management page.

---

**New Content Rules for DocuShare**

Several content rule actions have been introduced for DocuShare.

**Auto create Folders with metadata Content Rule**

Auto create Folders with metadata content rule moves an object to a location defined by a path string that supports property substitution, with the metadata of the document. This content rule automatically files repetitive documents into a logical collection hierarchy based on document metadata. The collection class can be specified while creating the content rule and the folders are created with that collection class. All the metadata names that are same for the object and the new folders that are created by the tool, get the property value, from the object to the folders. The Action for this content rule is **Auto create Folders with metadata**.

An example that uses this Content Rule could be filing invoices by vendor name and date. The folders can be created by any custom collection that the user specifies while creating the content rule. All the metadata of the Invoice Document can be metadata of all the folders that the tool creates if name of both the document and the collection are the same.

Ensure that the collection and the object metadata names are the same if the collection(s) should inherit the property values from the object.

**Content rule configuration interface includes:**

- Filter by dialog box which allows the user to filter the destination collections.
- Destination Collection—Set the destination collection in which you create collection hierarchy according to the path string.
- Collection Class/type—Select the Collection Class/type
- Owner—Set the owner of the sub-collections. If the owner is not selected, the owner of the new objects is the owner of their parent.
- Path—Path string defines the new location to which objects are moved. The path string supports substitution of object property values. The path string also supports to create folders with any constant static string. If the property does not exist, that level is not created in the hierarchy. User can change the date format when it comes to date properties.

   **Example of a path string** can be:
Invoices/$\{\text{invoice\_type}\}/$\{\text{vendor}\}/$(\text{create\_date},\text{format}, \text{MMM-dd-yyyy})/$\{\text{modified\_date}\}$

Notes on path string definition:
- If the path string is empty, then the document is directly moved to the destination collection.
- Object property names must be inside $(\ )$, to let the content rule obtain the corresponding property values.
- The default date format is MM/dd/yyyy, for example, 08/30/2015. User can change the date format, for example, $(\text{create\_date},\text{format}, \text{MMM-dd-yyyy})$. The detailed explanation in next section.

According to the path string above, if an object triggers the content rule with property values:

- invoice\_type: Software
- vendor: Xerox
- create\_date: 01/01/2015
- modified\_date: 01/01/2016

In the target collection, the content rule creates collection hierarchy:

- Invoices/Software/Xerox/ Jan-01-2015/01/01/2016

The object is then moved to 01/01/2016 folder.

- Date format—The syntax to change date format is:
  \$\{\text{date property name}, \text{format}, \text{date format}\}\$

  The user only needs to define date property name and date format. The user must use a comma “,” to split the parameters, for example, $(\text{create\_date},\text{format}, \text{MMM-dd-yyyy})$.

  The following common date formats are solid to use:

<table>
<thead>
<tr>
<th>Date format</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>MM/dd/yyyy (default format)</td>
<td>01/30/2015</td>
</tr>
<tr>
<td>MMM-dd-yyyy</td>
<td>Jan-30-2015</td>
</tr>
<tr>
<td>EEE; MMM-dd-yyyy</td>
<td>Fri; Jan-30-2015</td>
</tr>
<tr>
<td>EEE; MMM-dd-yyyy;hh:mm:ss;zzz</td>
<td>Fri; Jan-30-2015;12:00:00;PST</td>
</tr>
<tr>
<td>MM/dd/yy</td>
<td>01/30/15</td>
</tr>
<tr>
<td>dd-MMM-yy</td>
<td>30-Jan-15</td>
</tr>
</tbody>
</table>

  The following date pattern letters are defined:

<table>
<thead>
<tr>
<th>Letter</th>
<th>Date or Time Component</th>
<th>Presentation</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Era designator</td>
<td>Text</td>
<td>AD</td>
</tr>
<tr>
<td>y</td>
<td>Year</td>
<td>Year</td>
<td>1996; 96</td>
</tr>
<tr>
<td>Y</td>
<td>Week year</td>
<td>Year</td>
<td>2009; 09</td>
</tr>
<tr>
<td>M</td>
<td>Month in year (context sensitive)</td>
<td>Month</td>
<td>July; Jul; 07</td>
</tr>
<tr>
<td>Letter</td>
<td>Date or Time Component</td>
<td>Presentation</td>
<td>Examples</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------------------</td>
<td>--------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>L</td>
<td>Month in year (standalone form)</td>
<td>Month</td>
<td>July; Jul; 07</td>
</tr>
<tr>
<td>w</td>
<td>Week in year</td>
<td>Number</td>
<td>27</td>
</tr>
<tr>
<td>W</td>
<td>Week in month</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>D</td>
<td>Day in year</td>
<td>Number</td>
<td>189</td>
</tr>
<tr>
<td>d</td>
<td>Day in month</td>
<td>Number</td>
<td>10</td>
</tr>
<tr>
<td>F</td>
<td>Day of week in month</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>E</td>
<td>Day name in week</td>
<td>Text</td>
<td>Tuesday; Tue</td>
</tr>
<tr>
<td>u</td>
<td>Day number of week (1 = Monday, ..., 7 = Sunday)</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>a</td>
<td>Am/pm marker</td>
<td>Text</td>
<td>PM</td>
</tr>
<tr>
<td>H</td>
<td>Hour in day (0-23)</td>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>k</td>
<td>Hour in day (1-24)</td>
<td>Number</td>
<td>24</td>
</tr>
<tr>
<td>K</td>
<td>Hour in am/pm (0-11)</td>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>h</td>
<td>Hour in am/pm (1-12)</td>
<td>Number</td>
<td>12</td>
</tr>
<tr>
<td>m</td>
<td>Minute in hour</td>
<td>Number</td>
<td>30</td>
</tr>
<tr>
<td>s</td>
<td>Second in minute</td>
<td>Number</td>
<td>55</td>
</tr>
<tr>
<td>S</td>
<td>Millisecond</td>
<td>Number</td>
<td>978</td>
</tr>
<tr>
<td>z</td>
<td>Time zone</td>
<td>General time zone</td>
<td>Pacific Standard Time; PST; GMT-08:00</td>
</tr>
<tr>
<td>Z</td>
<td>Time zone</td>
<td>RFC 822 time zone</td>
<td>-0800</td>
</tr>
<tr>
<td>X</td>
<td>Time zone</td>
<td>ISO 8601 time zone</td>
<td>-08:00; -0800; -08:00</td>
</tr>
</tbody>
</table>

For more information, go to [http://docs.oracle.com/javase/8/docs/api/java/text/SimpleDateFormat.html](http://docs.oracle.com/javase/8/docs/api/java/text/SimpleDateFormat.html)

**Copy Template as a Content Rule**

Copy Template can be invoked as a Content Rule. As a content rule, templates are defined on the DocuShare server, built from Collections or collection clones only, as the base object. It can further have other objects. Multiple distinct templates may be defined, since each content rule can have its own template.
When creating a Content Rule, the user selects **Copy Paste the selected Template** as the **Action for the Content involved**, that is the action to be performed when the event occurs. The action is performed on the content that triggers the action.

On the following page of the content rule, the user selects the source collection for template, the objects to be copied when pasting that template, checking the boxes based on whether the permission (Access Control List) and metadata should be copied along with the objects, if ownership should be maintained for the newly pasted objects, and if the source collection itself should be pasted or only the contents (children under the template that’s copied) have to be copied.

The completed content rule reflects the action performed, the Source Collection for the template, select objects to be copied, the Boolean true and false for Copy ACL and Copy metadata, and Boolean whether to include source collection while copying.

**Inheritance Content Rules**

Inheritance Content Rules allow children documents and collections to inherit property values from the parent collection. If immediate parent collection has empty property value, they inherit the property value from other ancestor collections. That is, it looks for a non-empty value from the immediate parent first and if it is empty it looks for a value in the object’s grandparent property and so on until it reaches a level above that is set in ‘Action Settings’ of the content rule.

When travelling upwards to inherit, if there are multiple parentages, the climb upwards stops, and the value is not inherited. **Note:** Multiple parentages are not supported for this inheritance.

At the time of content rule configuration, the property names are indicated from which the inheritance should occur. The user can select the parent object and property name from where the inheritance occurs to destination object and property name which should receive the inherited value.

This property inheritance is only initiated from the bottom of the tree. Setting a property above in the tree does not automatically push that property down the descendants.

**Content Rule**

When creating the Content Rule, select the **Inherit Property values to children** action.

On the next page, under Action Settings, specify the options for the action.

**Action Options for Inherit Property values to Children**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection from which the Inheritance cannot happen.</td>
<td>Use the <strong>Filter by</strong> dialog box to filter the objects of interest that is typed, such as Collection 12. Select <strong>Go</strong> to initiate the Filter. Select <strong>SHOW ALL</strong> to display all locations. The collection can be searched by either entering the collection handle or the collection title (full or the substring), to search in ‘Filter by’ box. If there’s a specific collection under this collection (where content rule is setup), which should not support inheritance of property, then that collection can be selected in select box, ‘Collection from which inheritance cannot happen’ and inheritance of property does not occur in that collection hierarchy.</td>
</tr>
</tbody>
</table>
### Action Options for Inherit Property values to Children

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Inherit under the whole tree      | If ‘Inherit under the whole tree’ check box is checked and the content rule triggers and if a hierarchy is moved, the property value is inherited for each leaf (document or collection, depending upon is collection/document properties are selected in the Inherit Property List), in that hierarchy.  
Note: This should NOT be confused with the Event Triggers | Event applies to: menu on ‘page 2’ of the content rule setup. This menu indicates that the event can be applied to “This container and all levels of contents”. This means that if the object is added to any level in the hierarchy then the content rule should get triggered.  
Whereas, with **Inherit under the whole tree**, once the content rule triggers, should the whole tree from that object be inheriting the property value or not, gets configured by checking this check box ‘Inherit under the whole tree’. |
| Overwrite the previous values     | If checked, overwrites any previous value of the property that is inheriting the value from its parent. If unchecked, only empty values inherit its parent value and non-empty values does not change for the object                                                                                       |
| Level UP, to look for the value to inherit | In the **Level UP, to look for the value to inherit** dialog box, type the value to inherit (such as root). In this case, we can specify, till which level in the parents should the user go up and look for a non-empty value. If we should be looking for a non-empty value till the last root (Home Collection), then write ‘root’ which setting up this value. Or else, we can specify 1,2,3 and so on….  
For example, in the following example of a document,  
Location: Home \ … \ ABC Company \ Keep One year \ Constant String \ Oct/19/2019 \ test.pdf Properties  
If the value of ‘Level UP, to look for the value to inherit’ is specified 1, then while inheriting a value of property for the document test.pdf for a non-empty value only for the collection Oct/19/2019. If the value of the property for Oct/19/2019 is empty the property is not inherited to the document test.pdf.  
Whereas, if the value of ‘Level UP, to look for the value to inherit’ is ‘root’ then this tool iterates to all parents one-by-one until it finds a non-empty value or it reaches HOME. ‘root’ is its default value. |
| Values to NOT inherit             | Enter any values to NOT inherit in the dialog box (such as RandompropertyValue). If there are some specific values that should not be inherited, they can be specified here. More than one property value can be comma separated. The Full property Name can be specified in ‘Full Source Property Names for above values’. Enter the Full Source Property Names for the above values into the dialog box (such as Collection.summary). |
### Action Options for Inherit Property values to Children

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Inherit Property Options      | Under the Inherit Property Options, the Inherit property list can be constructed of the format:<br>
|                               | `<All Collection Objects (for parent objects)>.<Inherit properties from parent> → <Destination Collection Document Object>.<Destination Property>`                                                              |
|                               | For example:<br>
|                               | • All Collection Objects (for parent objects) = Collection<br>
|                               | • Inherit properties from parent = Background Image<br>
|                               | • Destination Collection Document Object = Document<br>
|                               | • Destination Property = Author<br>
|                               | That is: Collection.bg_image → Document.author<br>
|                               | In this example, Collection.bg_image writes its value to Document.author. i.e. Document.author inherits the property Value from its Collection parent’s property: Collection.bg_image. |
|                               | More than one property can be inherited by selecting the link + Inherit more properties?<br>
|                               | Each row can be deleted by selecting the minus sign at the end of each row.                                                                                                                                  |

The final page of the content rule configuration indicates the action performed (“Inherit property values to children”), the action settings which include Collection from which the Inheritance cannot happen, Overwrite the previous values, inherit under the whole tree (Boolean: true or false), Level UP to look for the value to inherit (such as root), values to NOT inherit (such as RandompropertyValue), Full Source Property Names for the above values (such as Collection.summary), and the Inherit property list (such as Collection.bg_image>Document.author, Collection.description>Document description, Collection.description>Collection.description,
10. Running searches

About searches

DocuShare search features enable the user to quickly find objects on the site. Simple word searches can be performed by having DocuShare find the objects that contain the text specified. Several search terms can also be combined to find specific objects, such as all documents authored by one user that contain the word DocuShare in their titles. When searching for objects, the scope of a search can be defined.

When an object is added to a container, DocuShare stores the object’s properties (also called metadata) in a database. If the Administrator has enabled content indexing, the content of document is also stored. When content indexing has been enabled, document content can also be searched.

In addition, DocuShare uses a process called stemming to find objects that contain variations of the word specified. For example, a search for the word mouse finds the word mice.

DocuShare provides another type of search called quick search. If the site is set up to use this search, refer to the DocuShare Quick Search Supplement on the Help Desk.

Viewing new content on the site

From any page, you can display a list of the content that has been added or changed on your site. This lets you quickly find any new or recently changed object or content that might be of interest to you.

To find out what is new:

1. On the navigation bar, click Recent.
   DocuShare displays the list of content that has been added or changed.

2. To change the search query used to display the list of new or changed content, click the Refine Search link.
   The Refine Search page appears.

3. Change any of the search properties and click the Search button. Click a field name for a description of the property, or see Running an advanced search.

Note: If a user is a guest and they click Recent on the navigation bar, DocuShare lists the content that has been added or changed during the past 24 hours. If you are a logged-in user and you click Recent on the navigation bar, DocuShare lists the content that has been added or changed since you last clicked Recent.
Searching for objects

The navigation bar provides a search area that lets you quickly search for objects and content. You do not need to be logged into DocuShare to run a search.

To run a simple search:

1. On the navigation bar, enter a word or phrase in the **Search** field. If you want to find objects that include any one of several words, separate each word with a comma. You can exclude common words such as from, it, and where.

   DocuShare searches are not case-sensitive. If you want to search for a word with exact capitalization, precede the word with a tilde character. For example, to search for HTML, enter ~HTML.

   **Note:** You can combine search words using the logical operators AND, NOT, and OR. Type the operator in uppercase letters and type a plus sign (+) before and after the operator instead of a space (for example, fruits+AND+vegetables; fruits+AND+vegetables+NOT+produce).

2. If you are running the search from a page other than the site home page, select a search scope from the **In** menu.

3. Click **Search**.

   DocuShare displays the search results. For documents, DocuShare either provides a snippet of the document content with the search term highlighted or displays the document’s abstract if the search term is not found in the content. You can click the **Show/Hide Details** link to control this display. You can also review the search criteria by clicking **Query Details**.

Search options

When running a simple search, you can specify several options to narrow the search and to control how the search results are displayed.

To run a simple search using extended search options:

1. Enter the search words in the **Search** field.

2. Click the small **Gear** icon next to the **Search** field to open the Extended Search section. Specify any of the following information:

   **Search Text Contained In**—Specifies the location of the search words. **Any Part** searches the object’s content and properties.

   **Last Modified**—Limits the search to objects that were last changed within a specific time period.

   **Object Types**—Specifies the type of objects to search.

   **Document Types**—Searches for all types of documents or a specific type. The **Object Types** must be set to **All Object Types, Documents & Collections** or **Documents Only**.

   **Maximum Results**—The maximum number of objects to display in the search results list. DocuShare orders the results by displaying the most relevant objects first.

   **Sort Results**—The order in which to display the search results.

3. Click **Search**.
Running an advanced search

Using the Advanced Search page, you can further narrow a search by combining search terms, specifying ranges, and searching for specific objects and documents.

To run an advanced search:

1. On the navigation bar, click the Advanced link.
2. In Search Text Contained In, enter the search term. Create a search term by selecting an operator, entering the search word or words (separate each word with a space) or the search character or characters, and then selecting where the search words or characters should occur.
   - If you want DocuShare to search for an exact word, enclose the word in quotation marks. If you want to search for a word with exact capitalization, precede the word with a tilde character.
   - You can click + add search term to create another search term using a logical operator. See the table of Logical operators for a description of each logical operator.
   - Note: For information on how to use wildcard and non-alphanumeric characters in a search term, see Using reserved characters in a search.
3. If you are running the search from a page other than the site home page, select a search scope from the Search Within menu.
   - Note: To search for notifications and content rules, the search scope must be set to the entire site.
4. In the Maximum Results field, select the maximum number of objects to display in the search results list. DocuShare orders the results by displaying the most relevant objects first.
5. In the Sort Results field, select the order in which to display the search results.
6. Under Limit Search to Date Range, enter the date range to use when searching for objects. Create a date range by selecting options from the menus and entering a date.
   - You can click + add date range to create a second date range.
7. Under Find Results Using Relative Date, create a search relative to today's date by doing one of the following:
   - To create a relative search without a start or end date, select a date property, select an operator, enter the number of days, and then select Days Ago or Days from Now. You can click + add range and create another search term.
   - To create a search with start and end dates, select a date property, select an operator, enter the number of days, and then select Days Ago or Days from Now. Then click + add range and create another search term and enter 0 in the days field.
   - Note: When you save a search query that uses a relative date and then run the search later, the query uses the date on which the search is run.
8. Under **Find Results with Numeric Range**, enter the numeric range to use when searching for objects whose properties have numeric values.

   You can click **+ add numeric range** to create a second numeric range.

   **Note:** This field appears if an object has a numeric property that is searchable.

9. Under **Find Results Using Menu Values**, select the menu and value to use when searching for objects.

   You can click **+ add search term** to create a second search term.

10. Under **Object Types to Search**, do one of the following:

    – To search all the objects on the site, click **Search all object types**.

    – To search specific objects only, click **Limit search to selected object types** and select the objects to search from the list.

11. If you are searching for documents, under **Document Types to Search**, do one of the following:

    – To search all types of documents, click **Search all document types**.

    – To search specific types of documents, click **Limit search to selected document types** and select the types of documents to search from the list. Each document type is specified by its MIME type.

12. Click the **Search** button.

    DocuShare displays the search results. For documents, DocuShare either provides a snippet of the document content with the search term highlighted or displays the document’s abstract if the search term is not found in the content. You can click the **Show/Hide Details** link to control this display.
### Logical operators

<table>
<thead>
<tr>
<th>Logical operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>And</strong></td>
<td>Searches for objects that contain all the search terms. For example: Search for objects where “Title contains Training And Summary contains Basic Product.” The search would return only objects that have the word “Training” in the Title, and the phrase “Basic Product” in the Summary.</td>
</tr>
<tr>
<td><strong>Or</strong></td>
<td>Searches for objects that contain one of the search terms. For example: Search for objects where “Title contains Advanced Or Summary contains Administrator.” The search would return objects that have either the word “Advanced” in the Title or the word “Administrator” in the Summary, or both the word “Advanced” in the Title and “Administrator” in the Summary.</td>
</tr>
<tr>
<td><strong>And Not</strong></td>
<td>Searches for objects that contain one search term and not the other. For example: Search objects where “Title contains Technology And Not Title contains Marketing.” The search would return only those objects where Technology was in the Title, but not return objects if Marketing were also in the Title.</td>
</tr>
</tbody>
</table>

### Using reserved characters in a search

You can use these wildcard characters when building a search:

- **Question mark (?)**—Specifies any single alphanumeric character. For example: ?an returns ban, can, dan, fan, etc.
- **Asterisk (*)**—Specifies any number of alphanumeric characters in one word. For example: corp* returns corporal, corporate, corporation, corpulent, etc.

To find objects that include a wildcard character, tilde (~), or double quotation mark ("), use the equals operator, precede the character with one backslash (\), and select the specific property name.

**Example**: To search for a document named “ReadFirst enter:

`equals "ReadFirst In Title.`

To find objects that include other non-alphanumeric characters, such as a parenthesis or an equal sign (=), use the equals operator and select the specific property name.

**Example**: To search for (650) 123-4567, enter:

`equals (650) 123-4567 In (User) Phone`
Saving a search query

After running an advanced search, you can save the search query so you can run the same search again later or share it with other users. To save a search query, you must be logged in.

To save the query used in a search:

1. Define your search terms and run a search.
   The search results display.
2. From the Add menu, select SavedQuery.
   The Add SavedQuery page appears.
3. In the Title field, enter a title for the saved query.
4. Enter any optional information. Click a field name for a description of each property.
5. Click Save Search.
   The Locations page appears.
6. Do one of the following:
   – To find specific containers, enter any part of a container title in the Search field. Click the Go button.
   – To display all containers, click Show All (if displayed).
   – To display your favorite containers, click Show Favorites.
7. In the Possible Locations field, select the containers in which you want the saved query to appear and click the Add button. To select multiple containers, use the Ctrl key (Windows) or the Command key (Macintosh).
8. In the Selected Locations field, select any containers in which you do not want the saved query to appear and click the Remove button. To select multiple containers, use the Ctrl key (Windows) or the Command key (Macintosh).
9. Click Update Locations.
   DocuShare adds your search query to the container. When you click the saved query, DocuShare runs the search using the saved search terms and displays the results.

Application Connector

The Application Connector is a URL based search. It searches for all Documents, custom Documents, Collections, and custom Collections for given property in URL in DocuShare.

As an example, the following Application Connector URL searches for all the Documents, custom Documents, Collections, and custom Collections where summary equals 'HR' or First Name contains deep.
In the above URL,

- **objectType** is the custom object. You may provide more object types to search by separating them with a comma (,). For example: `objectType=EHRObject,Document,Collection`
  - If `objectType=all` the Application Connector searches for all the Documents, custom Documents, Collections, and custom Collections.
- **summary-equals-or** is the property to search in the given object types where:
  - **summary** is the property name of the document or collection object. (For Example: `title`, `first_name` etc.) **Note: The property name is case sensitive.**
  - **equals** is the operator (Default is `contains`)
  - **or** is the Boolean operator linking this expression with the next expression (default is **and** if not specified).
  - An example of allowed property query params include `summary=HR`, `summary-contains=HR`, `summary-equals=HR`, `summary-equals-and=HR`

The following Application Connector URL searches for all Documents, Collections, custom Documents, and custom Collections, where the Batch Number is 123.

`http://<HOSTNAME>:8080/docushare/jsp/DocumentConnector/Search.jsp?objectType=all&batchNumber=123`

If the search criteria match multiple Documents or Collections, the DocuShare search page displays all the results.

If the user is not logged in to DocuShare and clicks on the Application Connector URL. The URL then redirects to the DocuShare login page.

Login to DocuShare displays the search result.

See the **Application Connector Implementation Guide** for more details.
11. Using personal home page

About My DocuShare

My DocuShare provides a single location from which you can conveniently manage personal content as well as access the content on your site. A link to My DocuShare appears on the site home page and on the navigation bar, as a tab and as the house icon next to your username.

My DocuShare consists of areas called portlets; each portlet has a different use. You can open and close a portlet by clicking the small triangle next to the portlet title.

- **Personal Collection**—A collection for private content.
- **Workspaces**—The workspaces you have access to and own.
- **Site Home**—The top-level collections on your site.
- **Favorite Calendars Combined**—A combination of the calendars in your Favorites.
- **Personal Trashcan**—Your deleted objects.
- **Favorites**—Links to your frequently used objects.
- **My Groups**—The groups of which you are a member.
- **Tasks**—The routing tasks assigned to you.

Managing favorites

To conveniently access frequently used objects from a single location, you can add them to your favorites. Any object you add as a favorite is a link to the original object, not a copy. If the original object is deleted, it no longer appears in your favorites.

To add an object to your favorites:

1. Locate the object that you want to add to favorites.
2. Click the checkbox that appears next to the object’s title.
3. From the Edit Selected menu, select Add to Favorites.
4. On the Confirm Add to Favorites page, click Confirm.
5. Go to My DocuShare.

The object you added appears under Favorites. The Show menu lets you display one type of favorite object, such as favorite documents. You can click the Favorites heading to display your favorites in a collection listing. In this view you can use standard collection features.

**Note:** Another way to add an object to your favorites is by clicking the object’s Add to Favorites icon. The icon is the outline of a star. Once you have made an object a favorite, the star turns yellow.
To remove an object from your favorites:

1. Go to **My DocuShare**.
2. Click the **My Favorites** heading.
3. From the **Edit Selected** menu, select **Remove Favorite**.
4. On the Confirm Remove from Favorites page, click **Confirm**.

**Note:** You can remove an object from your favorites by clicking the object’s Add to Favorites icon. The icon turns from yellow star to the outline of a star.

Once you have removed the object from your favorites, the object still appears in its original locations.

## Using your personal collection

Your personal collection on My DocuShare is a private repository for your objects. By default, only you and a group of Administrators called Content Administrators have full access to the collection.

**Note:** Your Administrator can choose to set up your site to not use personal collections.

To add an object to your personal collection:

1. Go to **My DocuShare**.
2. Click the **Personal Collection** heading.
3. From the **Add** menu, select the type of object you want to add.
4. On the Add page, enter the required information, and click **Apply**.
5. Go to **My DocuShare**.

The object you added appears under **Personal Collection**. The **Show** menu lets you display one type of object, such as documents.

There are other ways to add objects to your personal collection: see Changing the location of objects and Adding documents using drag and drop.

## Viewing your personal collection

To view your personal collection in full page:

1. Go to **My DocuShare**.
2. Click the **Personal Collection** heading.

The objects display in a collection listing. In this view you can use standard collection features such as adding new objects and changing the collection’s properties.

**Note:** You can delete your personal collection and, optionally, its contents. However, the next time you access My DocuShare your personal collection appears.
Using your favorite calendars

All your favorite calendars are combined and displayed in one calendar under the **Favorite Calendars** heading. This allows you to merge the events from separate calendars into a master calendar. For example, you can add individual vacation calendars to your favorites to create a single vacation calendar for a group.

To add favorite calendars:

1. Locate the calendar that you want to add to favorites.
2. Do one of the following:
   - Click the calendar’s **Add to Favorites** icon.
   - Click the checkbox that appears next to the calendar’s title. From the **Edit Selected** menu, select **Add to Favorites**. On the Confirm Add to Favorites page, click **Confirm**.
3. Repeat steps 1 and 2 to add additional calendars to favorites.
4. Go to **My DocuShare**.
   The single calendar appears under **Favorite Calendars**.
5. Using the **Show** menu, you can switch between daily and weekly views of the calendar.

Using your personal trashcan

Your personal trashcan holds both the objects you delete as well as the objects you own that other users delete. You can use your personal trashcan to restore and expunge deleted objects, provided your Administrator has not expunged the objects from the site-wide trashcan.

**Note:** Your Administrator can choose to set up your site to not use personal trashcans.

To restore or expunge a deleted object:

1. Go to **My DocuShare**.
2. Under **Personal Trashcan**, select the object that you want to restore or expunge.
3. From the **Action** menu, do one of the following:
   - Select **Restore** to restore the object to the location from which it was deleted.
   - Select **Expunge** to remove the object from your site.

**Note:** If the location is a collection or workspace and it was deleted, then the object is restored to your personal collection. If the location is a non-collection type of container (such as a calendar or a discussion) and it was deleted, then the object becomes an orphaned object; your Administrator can relocate an orphaned object.
Viewing your groups

All the groups of which you are a member display under the My Groups heading. You can click a group name to display its Properties page.

Viewing your routing tasks

All the routing tasks assigned to you are listed under the Tasks heading. This provides you with a quick view of the tasks to which you need to respond. You can click a task to open its window.

In addition, clicking the Tasks heading displays the My Tasks window. You can view both the tasks assigned to you and the tasks you assigned, and your routing task history in this window. For more information on document routing, see Automating work processes.
A. Task Permissions

Permissions required for tasks on a site using three permissions

The table below lists the permission required for each task on a site that is set up to use three permissions.

<table>
<thead>
<tr>
<th>User Task</th>
<th>Reader</th>
<th>Writer</th>
<th>Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Objects</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add object</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>View object content</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View object properties</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change object properties</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>View object change history</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View object permissions</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change object permissions</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Change object owner</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Change object location</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>object</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>current location (for copy)</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>current location (for move)</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>new location</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Delete object</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Document</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View document and versions</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add new document version</td>
<td>•</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Permissions required for tasks

<table>
<thead>
<tr>
<th>User Task</th>
<th>Reader</th>
<th>Writer</th>
<th>Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit document</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Lock document</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Unlock document*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export a document</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Route a document</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Approve or Disapprove Review and Make Changes</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Acknowledge Receipt Information</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add comment to document, weblog entry</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>View comment on document, weblog entry</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td><strong>Content Rule</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create content rule</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>View content rule</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Change content rule</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Copy content rule</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td><strong>Notification</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add notification to object</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>View object notifications</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Create recipient list for notification</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td><strong>Scan Cover Sheet</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create and use scan cover sheet for object</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td><strong>Weblog</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add weblog entry text</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Edit weblog entry text</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Approve weblog entry</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td><strong>Wiki</strong></td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Add wiki page</td>
<td></td>
<td>•</td>
<td></td>
</tr>
</tbody>
</table>
**Permissions required for tasks**

<table>
<thead>
<tr>
<th>User Task</th>
<th>Reader</th>
<th>Writer</th>
<th>Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit wiki page text</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Rename wiki page</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Delete wiki page</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td><strong>Workspace</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Re-assign membership group</td>
<td></td>
<td></td>
<td>•</td>
</tr>
</tbody>
</table>

* Not controlled by permissions; user who locked the document and content Administrators can unlock the document.

**Permissions required for tasks on a site using six permissions**

The table below lists the permission required for each task on a site that is set up to use six permissions. * Not controlled by permissions; user who locked the document and content Administrators can unlock the document.
B. WebDAV folders

Using WebDAV folders

DocuShare supports the WebDAV (Web-based Distributed Authoring and Versioning) protocol, which enables you to access DocuShare collections and documents through a WebDAV-compliant folder. You do not need client software installed on your computer. Depending on your operating system, do one of the following:

- If you are a Windows XP user, simply go to My Network Places to add a DocuShare server as a network place.
- If you are a Macintosh OS X user, select Connect to Server to add the URL for a DocuShare server.

**Note:** In both Windows and OS X, you must append the DocuShare server’s URL with /webdav. When you are prompted to log in, use your DocuShare username and password.

Document titles in WebDAV folders

Your DocuShare Administrator controls how document titles are displayed in collections. For example, a title might have a file extension appended to it. If you have any questions about how document titles are displayed, see your Administrator.
Index

A
access list
  changing, 29
  viewing access list, 29
accounts, See group account, user account, 12
Add to Favorites (Edit Selected menu), 34
adding objects
discussions
  adding to a container, 73
group accounts
  creating group account, 16
user accounts
  creating user account, 12
And Not operator, using in searches, 111
And operator, using in searches, 111
annotations
  add types, 48
  merge, 50
Application Connector, 7, 113

C
calendar
  changing access list, 29
  changing its location, 32
  changing owner, 30
month view, calendar; week view, calendar; day view, calendar
day view
  month view
  week view
  changing views, 25
Change Location (Edit Selected menu), 34
Change Owner (Edit Selected menu), 34
changing location of object, 32
  using copy, cut, and paste; Copy (Edit Selected menu); Cut (Edit Selected menu), 33
collection
  adding collections
    adding to a container
  calendars, 24
    changing access list, 29
    changing its location, 32
    changing owner, 30
    viewing properties
      changing properties
        viewing properties
          changing properties
            viewing properties
              changing properties, 26
  adding document to
    adding to collection
documents, 37
  viewing change history
    change, viewing; change history, viewing for objects
    viewing change history
    editing multiple objects in
      editing multiple in collection, 34
Zip and Download (Edit Selected menu)
  zip and download
    zip and download, 35
list view, collection; images view, collection; email view, collection
  list view
    images view
      email view
        changing views, 25
comments
  deleting from weblog entry, 78
  viewing for weblog entry, 77
content rule
  creating
    content rules, 98
  changing
    about disabled content rules, 99
    about
      event triggers, 97
    deleting
      content rule
        restoring after deleting, 100
Content Rule
  Copy Template, 104
Content Rules
Auto create Folders, 101
Inheritance, 104
Copy (Edit Selected menu), 34
Copy Shortcuts (Edit Selected menu), 34
Copy Template
Content Rule, 104
Web Function, 33
Copy Template (Edit Selected menu), 35
Cut (Edit Selected menu), 34

D
Delete (Edit Selected menu), 35
deleting completed routing tasks you assigned deleting completed, 88
discussion about, 73
changing access list, 29
changing its location, 32
setting expiration date for topics, 73
adding topics
adding to discussion topics to discussions replying to adding to topic, 74
document about, 37
annotate, 48
changing access list, 29
changing its location, 32
changing owner, 30
adding comments to adding to a document; adding comments to a document viewing comments viewing for document document comments, 52
editing checking out checking in new version; checking out a document; checking in an edited document; version comments, adding; editing a document adding edited document, 44
locking; locking a document unlocking, 47
downloading, 42
adding using drag and drop using to add documents, 38
exporting, 51
applying permissions to versions applying to document versions, 31
viewing and editing with document content document content and properties, 42
redact, 50
generating reports, 28
adding new version of existing adding new document, 45
viewing in HTML format a document in HTML format; HTML format, viewing a document in viewing HTML, 43
viewing in PDF format a document in PDF format; PDF format, viewing a document in viewing PDF, 43
viewing its version history; version history, viewing document version history viewing document version, viewing, 45
Document Upload Page, 39, 41
DocuShare, 8
accessing, 8
icons icons for objects, 22
User Interface, 9
logging in; logging out logging in logging out, 10
WebDAV folder, using with DocuShare and WebDAV folders, 124

E
event changing access list, 29
changing owner, 30

F
favorite calendars adding viewing favorite calendars See also favorite calendars[calendar aaa], 116
favorites adding objects to, 114
removing objects from, 115

G
Generate Report (Edit Selected menu), 35
Go to menu, 10
group account changing properties
group account, 17
deleting
  group account, 21
changing domain
  changing for group
    changing group domain, 19
sending email to members
  sending to a group
    sending email to group, 20
viewing change history
  change, viewing, 20
changing group members
  changing for group, 18, 19
changing group owner
  changing for group, 19
viewing usage quotas; usage quotas, viewing, 18
viewing properties
  group account, 17
guest user
  viewing what’s new on DocuShare, 107

H
home page
  features, 9
HTML tags, and wiki syntax, 79

I
icons
  for permissions, 28
Inheritance
  Content Rules, 104
initial permissions, setting for objects, 28

L
LDAP (Lightweight Directory Access Protocol)
  and user accounts, 12
  changing user password, 14
  changing username, 14
changing user domain
  changing domain
    changing for user, 15
logical operators
  types, 109, 111

M
membership group for workspace
  changing group assigned
    re-assigning membership group, 70
changing group members
  changing membership group members, 69, 70
Multiselect view, 27
Multiselect View (Edit Selected menu), 35
My DocuShare
  about, 114
  viewing personal collection
    See also personal collection[collection aaa], 115
viewing favorites
  viewing, 114
viewing groups of which you are a member
  viewing list of groups of which you are a member, 117
viewing personal trashcan
  using, 116
  and spaces
    and My DocuShare, 114
My Tasks
  using to check tasks you assigned, 86
  using to view progress reports, 88

N
navigation bar, 10
notification
  adding
    notifications
      receiving for a notification, 58
changing properties
  notification
    viewing properties
      notification, 61
customizing, 62
  turning off selected event notifications
    limiting number received for notifications, 59
about
  requirements for using
    events of interest, 58
restoring after deleting; restoring deleted objects
  deleting
    notification, 61
creating a recipient list for
  creating for notification, 60
time periods, 59
viewing, 59
  viewing the ones you own, 60

O
objects
  changing access list, 29
about
  about
    about, 22
deleting
object
deleting
deleting
deleting
deleting, 36
generating reports, 27
restoring after deleting, 36
searching for; searching for objects
running, 108
searching for, 110
See also calendar; collection; discussion;
document; event; group account; saved
query; topic; URL; user account; weblog; wiki;
workspace[objects
aaa], 10
Or operator, using in searches, 111
orphan object, 32, 36
owner
changing for object
changing owner
changing owner
changing owner, 30

Page Size property, using, 25
Past (Move) to Space (Edit Selected menu), 35
Paste (Edit Selected menu), 35
access list, 23
permissions
Reader permission, 23
permissions
Read Properties permission, 23
permissions
Writer permission, 23
permissions
Read Content permission, 23
permissions
Manager permission, 23
permissions
Read History permission, 23
permissions
Write Properties permission, 23
permissions
Write Content permission, 23
permissions
Manager permission, 23
access permissions, See permissions
See also access list; initial permissions, setting
for objects[permissions
aaa], 28
personal collection
adding objects to, 115
preferred version
changing preferred version, 46
object properties
viewing and changing for objects
object
object, 26

R
recipient list
changing for document routing, 85
redact document content
burn in redactions
burn in, 51
Rename (Edit Selected menu), 35
rendition
viewing for versions
viewing renditions
version renditions, 46
reply
attaching documents, 74
Reporting
Workflow Reporting, 9, 94
retain login for future, 10
Copy (Edit Selected menu); Cut (Edit Selected
menu); Delete (Edit Selected menu); Paste
(Edit Selected menu); Rename (Edit Selected
menu), 34
Route (Edit Selected menu), 35
routed document
acknowledging receipt of, 92
removing after sent for information, 92
reviewing, 91
approving
disapproving, 91
publishing new version of
publishing routed document, 89, 90
routing a document
automatically after adding to collection
setting up for routing documents
private, 86
to users
  routing to users, 83, 85
  including additional documents, 84
  routing order, 84
  types of routing tasks, 84
Routing Slip
  about; workflow, See routing a document, 83
Routing Slip
  re-using
  using a saved Routing Slip, 84
  saving
  a Routing Slip
  private, 85
routing tasks
  checking status of your tasks, 86, 88
  viewing all deleted
  viewing all, 93
  viewing for document
  viewing routing tasks in progress
  viewing deleted routing tasks
  viewing for document, 93
  viewing tasks assigned to you
  receiving when routing task is assigned
  using to view tasks assigned to you, 90
feed, using to view updated content on
DocuShare, 58

S
saved query
  changing access list, 29
  changing owner, 30
  viewing properties
  changing properties
  viewing properties
  changing properties
  viewing properties
  changing properties, 26
  viewing change history
  viewing change history
  viewing change history
  viewing change history, 26
  changing its location
  changing its location
  changing its location, 32
saving
  search query
  saving
  adding to container
  See also saved query[searches aac], 112
scan cover sheet
  creating, 53
  deleting, 54
using, 53
scanned document
  saving to a collection
  receiving URL after saving
  saving scanned document to a collection
  scanned document to a collection
  moving scanned document from, 56
  checking length of time in temporary
  collection
  checking how long scanned documents are
  stored, 55
placeholder document
  using scan cover sheets
  using, 37
scanning documents
  about, 52
scanning documents
  using scan cover sheets
  scanning using scan cover sheets; PDF file,
  creating by scanning, 53
scanning documents
  at a WorkCentre
  scanning at a WorkCentre; WorkCentre, and
  scanning documents; scan template, 54
scanning documents
  at an ApeosPort
  scanning at an ApeosPort, 55
search results
  redact, 50
searches
  using non alphanumeric characters
  using wildcards; reserved characters, using in
  searches; wildcards, using in searches;
  asterisk, using in searches; question mark,
  using in searches, 111
  how to specify exact word, 109
  using the document viewer, 48
searching for objects
  combining search terms
  using in searches, 109, 111
  running a word search, 108
  using search options, 108
Send to DocuSign (Edit Selected menu), 35
shortcuts portlet (workspace)
  adding objects to, 71
  removing objects from, 71
abstract (document), displaying and hiding in
  search results, 110
searches, 107
T
theme
  selecting for site
using a theme, 15
search words, separator, 108
topic
attaching documents, 74
changing access list, 29
viewing expired
deleting expired
expired topics
deleting
viewing, 75
trashcan
personal
site-wide; personal trashcan, 36
U
URL
adding
URLs
  events to calendars
  adding
    adding to calendar, 24
changing access list, 29
changing its location, 32
changing owner, 30
user account
changing properties
user account, 13
viewing list of
viewing list of
  searching for
    finding user and group accounts, 21
viewing activity history
activity, viewing; activity history, viewing
your activity history, 15
changing password, 13
viewing usage quotas; usage quotas, viewing,
14
viewing properties
user account, 13
user levels; Read-Only user; DocuShare user; CPX user
  and user levels, 12
logged-in user, and appearance of user icon, 21, 69
V
version, document
specifying maximum to save
and maximum versions, 38
changing properties
viewing properties
version, 47
viewing
  a document
    viewing, 42
  progress reports for routing tasks, 88, 89
  new content
    using, 107
W
Web Function
Copy Template, 33
weblog
adding to container
weblogs, 75
and site themes
and weblogs, 76
about
  moderated, 75
posting entries
  adding to weblog, 76
weblog entry
  approving, 77
  adding comment to
    adding to weblog entry, 77
deleting, 77
editing, 76
interwiki links
  using interwiki links, 81
wiki
  about, 78
  adding to container
    wikis, 78
  attaching documents, 80
  editing methods, 78
  inserting images, 80
  and site themes
    and wikis, 79
  viewing linked pages, 80
  adding content
    linking pages; WYSIWYG editor, and wikis, 79
wiki
  changing page name, 81
wiki
  printing wiki pages, 82
workspace
  adding content, 71
  adding
    workspaces, 68
  viewing calendars
  day view
    week view
      changing views; day view, calendar, 72
changing portlet properties
changing properties
changing portlet properties
changing properties
changing properties, 72
controlling access to, 69

about; content portlet (workspace); shortcuts
portlet (workspace); calendar portlet
(workspace), 68
adding shortcuts
removing shortcuts, 71